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MICROSURVEY END-USER LICENSE AGREEMENT 
 
This MicroSurvey End-User License Agreement (“Agreement”) is a legal and binding agreement 
between you (“Licensee”) and MicroSurvey Software Inc., a BC corporation (“MICROSURVEY”) 
concerning  the use of the MicroSurvey products (the “Product”), the software provided in 
connection with the use and operation of the Product, including  firmware and stored 
measurement data (collectively the “Software”) and all related documentation provided in 
connection with the acquisition of the Product (“Documentation”). The Software includes software 
owned by, and licensed from, third party licensors.  
 
By clicking the “I ACCEPT” check box and completing the process of installing the Software, 
LICENSEE consents to and agrees to be bound by all of the terms and conditions of this 
Agreement. BY CLICKING THE “I REJECT” CHECK BOX or IF LICENSEE disagrees with any of 
the terms or conditions of this Agreement, LICENSEE IS not permitted to install and/or use the 
Software, PRODUCT AND DOCUMENTATION. IF LICENSEE HAS ANY questions OR 
COMMENTS CONCERNING THIS AGREEMENT LICENSEE MAY CONTACT MICROSURVEY 
AT Westbank, BC Canada. 
 

1. Title to Product and Rights to Use Software and Documentation.  Title to the Product 
and the rights to use the Software and Documentation are conditioned upon the payment 
of the required purchase price and any applicable license and maintenance fees and 
Licensee’s acceptance of the terms and conditions of this Agreement.  

 
2. License.   

a. License Grant.  MICROSURVEY hereby grants Licensee a nonexclusive, non-
transferable, non-sublicensable right to (i) install and use one copy of the 
Software and Documentation on the Product and one copy for use on no more 
than one personal computer simultaneously, and , (ii) to access the stored 
measurement data generated by the Software, for Licensee’s own internal 
business purposes and in accordance with the terms and conditions of this 
Agreement.  MICROSURVEY also hereby grants Licensee a nonexclusive, non-
sublicensable right to reproduce the Documentation, solely as necessary for 
Licensee’s internal use of the Product and Software. 

b. Conditions and Restrictions.  The following conditions and restrictions apply to 
the use of the Product, Software and Documentation:  

 

i. Licensee shall not, and shall not attempt to, reverse engineer, 
decompile, disassemble or otherwise attempt to identify the source code 
of any object code portions of, distribute, modify, encrypt, or create 
derivative works of the Software, Documentation, and/or any stored 
measurement data in whole or in part, including, but not limited to, stored 
measurement data. 

ii. Licensee shall not use the Software or Documentation for any purpose 
not expressly permitted by this Agreement. 

iii. Licensee shall not copy any part of the Software, except that Licensee 
may make one copy of the Software for backup purposes only.  

iv. Licensee agrees not to remove or destroy any copyright, logo, 
trademark, trade name, proprietary markings, or confidentiality legends 
placed upon or contained within the Software or Documentation.  
Licensee shall not, and agree not to assist others to, circumvent or 
disable the license provisioning technology for the Software.  

v. Licensee’s license to the Software under this Agreement continues until 



 

it is terminated by Licensee or MICROSURVEY.  Licensee may 
terminate the license by discontinuing use of all or any of the Software 
and by destroying all Licensee copies of the Software and 
Documentation.  

vi. This Agreement will terminate automatically if (x) Licensee violate any of 
the terms or conditions of this Agreement, (y) MICROSURVEY publicly 
posts a written notice of termination on its website www.microsurvey.com 
(that, or any successor site, the “Site”); or (z) MICROSURVEY revokes 
this Agreement or issues a new agreement in writing or electronic form 
and conditions Licensee continued use of the Software upon acceptance 
of the new agreement.   

 
3. Ownership.  All rights, title and interest in and to the Software and Documentation 

including, without limitation, all copyright, patent, trade secret and other intellectual 
property rights shall at all times remain the property of MICROSURVEY, it licensors, or its 
suppliers, as applicable.  The Software and Documentation are licensed, not sold, and 
are protected by copyright and other intellectual property laws and treaties.  Licensee 
shall take appropriate steps reasonably calculated to notify others of MICROSURVEY 
and its licensor’s/suppliers’ ownership of the Software and Documentation. 

 
4. Warranty.  MICROSURVEY warrants that the Product will, for 90 days after the Effective 

Date (the “Warranty Period”), substantially conform to the Documentation; provided, that 
Licensee must notify MICROSURVEY in writing of any breach of the foregoing warranty 
within the Warranty Period.  For any breach of the foregoing warranty reported during the 
Warranty Period, MICROSURVEY will use reasonable efforts to promptly correct such 
defect without further charge.  If MICROSURVEY is unable to correct such defect, then 
MICROSURVEY will refund the license fees paid for the Product.  This represents 
MICROSURVEY'S exclusive liability and Licensee’s sole and exclusive remedy in the 
event of a breach of the foregoing warranty.  

 
5. Warranty Disclaimer.  EXCEPT AS DESCRIBED IN SECTION 4 (WARRANTY), 

MICROSURVEY HEREBY DISCLAIMS ALL WARRANTIES RELATING TO THE 
PRODUCT, SOFTWARE, AND DOCUMENTATION, INCLUDING WITHOUT 
LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-
INFRINGEMENT AND FITNESS FOR A PARTICULAR PURPOSE.  MICROSURVEY 
DOES NOT REPRESENT THAT THE OPERATION OF THE PRODUCT AND/OR 
SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE. WITHOUT LIMITING THE 
GENERALITY OF THE FOREGOING, MICROSURVEY MAKES NO WARRANTY THAT: 
(A) OPERATION OF THE PRODUCT AND/OR SOFTWARE WILL BE 
UNINTERRUPTED OR ERROR-FREE, (B) THE PRODUCT AND/OR SOFTWARE WILL 
MEET LICENSEE SPECIFIC NEEDS, (C) SPECIFIC RESULTS WILL BE ACHIEVED 
WITH THE PRODUCT AND/OR SOFTWARE, OR (D) ALL ERRORS OR FAILURES 
WILL BE CORRECTED. IN NO EVENT SHALL MICROSURVEY’S, ITS LICENSORS’, 
OR ITS SUPPLIERS’ LIABILITY TO LICENSEE FOR THE PRODUCT AND/OR 
SOFTWARE, WHETHER BASED ON CONTRACT, TORT, WARRANTY, OR ANY 
OTHER LEGAL THEORY, EXCEED THE AMOUNT OF PURCHASE PRICE PAID FOR 
THE PRODUCT AND ANY RELATED LICENSE OR MAINTENANCE FEES PAID BY 
LICENSEE. 

 
6. Exclusion of Damages.  TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE 

LAW, IN NO EVENT SHALL MICROSURVEY, ITS LICENSORS, OR ITS SUPPLIERS 
BE LIABLE FOR ANY SPECIAL, INCIDENTAL, PUNITIVE, INDIRECT, OR 
CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, BUT NOT LIMITED TO, 
DAMAGES FOR LOSS OF PROFITS OR OTHER DATA OR INFORMATION, OR FOR 
BUSINESS INTERRUPTION) ARISING OUT OF OR IN ANY WAY RELATED TO THE 



 

USE OF OR INABILITY TO USE THE PRODUCT AND/OR SOFTWARE, EVEN IN THE 
EVENT OF THE FAULT, TORT (INCLUDING NEGLIGENCE), STRICT LIABILITY, 
BREACH OF CONTRACT OR BREACH OF WARRANTY OF MICROSURVEY, ITS 
LICENSORS OR ANY SUPPLIERS, AND EVEN IF MICROSURVEY OR ANY of ITS 
LICENSORS OR SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES.  BECAUSE SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION 
OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, 
THE ABOVE LIMITATION MAY NOT APPLY TO LICENSEE. 

 
7. Limitation of Liability.  NOTWITHSTANDING ANY DAMAGES THAT LICENSEE 

MIGHT INCUR FOR ANY REASON WHATSOEVER (INCLUDING, WITHOUT 
LIMITATION, ALL DAMAGES REFERENCED ABOVE AND ALL DIRECT OR GENERAL 
DAMAGES), THE ENTIRE LIABILITY OF MICROSURVEY AND ANY OF ITS 
LICENSORS OR SUPPLIERS UNDER ANY PROVISION OF THIS AGREEMENT AND 
LICENSEE EXCLUSIVE REMEDY FOR ALL OF THE FOREGOING SHALL BE LIMITED 
TO THE AMOUNT ACTUALLY PAID BY LICENSEE FOR THE PRODUCT AND ANY 
RELATED LICENSE OR MAINTENANCE FEES PAID BY LICENSEE.  THE 
FOREGOING LIMITATIONS, EXCLUSIONS AND DISCLAIMERS (INCLUDING 
SECTIONS 5 AND 6 ABOVE) SHALL APPLY TO THE MAXIMUM EXTENT PERMITTED 
BY APPLICABLE LAW, EVEN IF ANY REMEDY FAILS ITS ESSENTIAL PURPOSE.  
LICENSEE ACKNOWLEDGES THAT (A) THE PROVISION OF THE PRODUCT AND 
SOFTWARE IS CONDITIONAL UPON MICROSURVEY EXCLUDING AND/OR 
LIMITING ITS AND ITS LICENSORS’ AND SUPPLIERS’ LIABILITY TO LICENSEE IN 
ACCORDANCE WITH THIS AGREEMENT, AND (B) THE EXCLUSIONS AND 
LIMITATION CONTAINED IN THIS AGREEMENT ARE FAIR AND REASONABLE IN 
ALL THE CIRCUMSTANCES KNOWN AT THE DATE OF THIS AGREEMENT. 

 
8. Indemnification.  Licensee agrees to defend, indemnify and hold 

MICROSURVEY, its affiliates, distributors, licensors, and suppliers harmless from and 
against any and all losses, damages, costs or expenses (including reasonable attorney's 
fees) (a) suffered by Licensee related in any way to the Product, Software, or this 
Agreement and/or (b) related to any claim or demand made by any third party in 
connection with or arising out of (i) any breach by Licensee of any of the terms and 
conditions of this Agreement, (ii) Licensee use or misuse of the Product or Software, (iii) 
Licensee violation of applicable laws, and/or (iv) Licensee violation of the rights of any 
other person or entity.  MICROSURVEY reserves the right, at its own expense, to 
assume the exclusive defense and control of (but not liability for) any matter otherwise 
subject to indemnification by Licensee.  Licensee will be liable to MICROSURVEY for 
reasonable attorney's fees in any such case. 

 
9. Support.   

a) General.  Except as set forth in Section 9(b) (Website Support) and 9(c) (Contract 
Support), MICROSURVEY shall have no obligation under this Agreement to maintain 
or support the Software.  Licensee may contact MICROSURVEY to inquire about 
MICROSURVEY’S commercially available support and maintenance services 
provided pursuant to separate agreements.  This Agreement shall not obligate either 
party to enter into any such separate agreement.  Any updates or error corrections to 
the Software that may be provided to Licensee from time-to-time, if any, shall be 
deemed Software hereunder and shall be licensed to Licensee under the terms and 
conditions of this Agreement.  If any such updates or error corrections are made 
available to Licensee, then Licensee shall promptly (a) implement such updates or 
error corrections, (b) cease using the earlier versions without such updates or error 
corrections, and (c) make such updates or error corrections available to the users of 
the earlier versions.  Licensee shall be solely responsible for procuring all hardware 
and third-party software necessary to operate the Software, including without 
limitation the items described on Appendix 1 attached hereto. 



 

b) Website Support. MICROSURVEY will use reasonable commercial efforts to host 
and maintain a web site (the “Support Site”) for the Software during its commercial 
life (as reasonably determined by MICROSURVEY) that will include some or all of the 
following features: 

 
• A “Frequently Asked Questions” section with answers to common questions 

about the Software.   

• A searchable “Helpdesk” section with general user instructions and information 
about the Software. 

• A  link to allow end users of the Software to download any bug fixes, error 
corrections or other updates to the Software that MICROSURVEY may make 
available through the Site. 

• “Contact MICROSURVEY” electronic response capability.  MICROSURVEY will 
use reasonable commercial efforts to respond within two (2) business days to a 
customer inquiry received via this system.  Answers to such inquires will be 
added to the FAQ’s, as appropriate. 

 
c) Contract Support. Upon mutual agreement in writing between Licensee and 

MICROSURVEY, or between Licensee and one of MICROSURVEY’S authorized 
reseller’s, MICROSURVEY will provide contracted support services to Licensee as 
may be agreed upon and related to the Software. 

 
10. Term and Termination. 

a) This Agreement is effective until terminated.  Licensee may terminate this Agreement 
at any time, with or without cause, upon notice to MICROSURVEY.  MICROSURVEY 
may terminate this Agreement for Licensee’s breach of this Agreement. 

b) Upon termination of this Agreement, Licensee shall immediately cease all use of the 
Software and Documentation and return to MICROSURVEY all copies of thereof 
within five (5) days after such termination.  Upon MICROSURVEY’S request, 
Licensee will certify in writing to MICROSURVEY that all such copies have been 
returned to MICROSURVEY.  The following provisions of this Agreement shall 
survive termination or expiration of this Agreement:  Sections 1(b) (Restrictions), 2 
(Ownership), 4 (Warranty Disclaimer), 5 (Exclusion of Damages), 6 (Limitation of 
Liability), 8 (Term and Termination), and 9 (General). 

 
11. General. 

a) Assignment.  MICROSURVEY may assign this Agreement without notice to 
Licensee. Licensee shall not assign this Agreement or transfer any of the rights, 
duties, or obligations arising under this Agreement without the prior written consent of 
MICROSURVEY.  This Agreement shall be binding upon, and inure to the benefit of, 
the permitted successors and assigns of the parties thereto. 

b) Amendments; Modifications. Notices of changes to this Agreement or other matters 
may be made to Licensee by displaying notices or links to notices to Licensee 
generally on the Site. 

c) Governing Law; Forum; Attorney’s Fees, Injunctive Relief.  The terms of this 
Agreement shall be construed and governed exclusively by the laws of the province 
of British Columbia, excluding the application of its conflict of law provisions and 
rules.  Any dispute, controversy  or claim between the parties arising out of or relating 
to this Agreement or a breach of this  Agreement shall be settled pursuant to the 
terms of this Section __(c) by arbitration before three neutral arbitrators (selected 
from a panel of persons having experience with and knowledge of the computer 



 

business), provided at least one of which arbitrators shall be an attorney, and 
administered by the Arbitrators Association of British Columbia in accordance with its 
Commercial Arbitration Rules in Kelowna, British Columbia.  Any provisional or 
equitable remedy which would be available from a court of law shall be available from 
the arbitrators to the parties.  Judgment upon the award of the arbitrators may be 
enforced in any court having jurisdiction thereof.  The parties hereby consent to the 
non-exclusive jurisdiction of the courts of the Province of British Columbia for any 
action (i) to compel arbitration, (ii) to enforce the award of the arbitrators or (iii) prior 
to the appointment and confirmation of the arbitrators, for temporary, interim or 
provisional equitable remedies, and to service of process in any such action by 
registered mail, return receipt requested, or by any other means provided by law.  
The application of the United Nations Convention of Contracts for the International 
Sale of Goods is expressly excluded.  

d) Severability.  The illegality, invalidity or unenforceability of one or more provisions of 
this Agreement shall not affect the legality, validity or enforceability of any other 
provision, and this Agreement shall be construed in all respects as if such illegal, 
invalid or unenforceable provision were deemed amended to achieve as near as 
possible the same economic effect as the original in a legal, valid and enforceable 
manner if possible. 

e) Further Relationships.  Neither party is obligated by this Agreement to enter into 
any further business relationship after the termination or expiration of this Agreement. 

f) Notices.  All notices under this Agreement shall be in writing, and shall be deemed 
given when personally delivered, when received if by nationally recognized courier, or 
three days after being sent by postage prepaid, certified or registered Canadian Mail, 
as applicable, to MICROSURVEY at MICROSURVEY’s address as set forth herein or 
to Licensee at the address that Licensee provided upon entering into this Agreement, 
or such other address as a party last provided to the other by written notice. 

g) Independent Contractor.  MICROSURVEY and Licensee are independent 
contractors.  No partnership, joint venture, or other joint relationship is created by this 
Agreement. 

h) Entire Agreement.  This Agreement represents the entire agreement between the 
parties relating to its subject matter and supersedes all prior representations, 
discussions, negotiations and agreements.  All changes, modifications, additions or 
deletions shall be effective immediately upon notice thereof, which may be given by 
means including, but not limited to, posting on the Site, or by electronic or 
conventional mail, or by any other means by which Licensee may obtain notice 
thereof.  Use of the Product and/or Software after such notice constitutes acceptance 
of such changes, modifications or additions. This Agreement may be amended at any 
time by mutual agreement of the parties.  
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4  Getting Started in MicroSurvey CAD 2010 

Welcome 
 
MicroSurvey Software Inc. is pleased to present our flagship product - MicroSurvey CAD 2010.   
 
This version contains over 1,000 bug fixes and general improvements.  Rather than attempt to 
add a list of new features, this time we have tried to make all of the routines work better, 
smoother, and more reliably.  This is part of the advantages of a maintenance system.  We can 
focus on how to improve the products so they work better for you, rather than trying to add 
features that might make an attractive upgrade purchase.  The two are not completely different, 
but the maintenance route is more focused on your needs. 
 
Included with this program are over 170 training movies and extremely comprehensive on-line 
help. Movies help make the printed documentation obsolete. That is why we reduced our 
manuals to a "Getting Started" document that contains the tutorials only.  Since the help system 
is electronic, we can treat it as a living document that can be updated with each service pack or 
new CD. 
 
We plan on introducing more exciting products for you in the next year. Watch our web site for 
news and updates on this and other MicroSurvey products. 
 
Yours truly, 

Darcy Detlor, 
President, 
MicroSurvey Software Inc. 
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Copyright Notices 
 
 

MicroSurvey CAD 2010 
 
 

Copyright © 2009 MicroSurvey Software Inc. 
All Rights Reserved 

 
 
MicroSurvey Software Inc. reserves the right to revise and improve its products as it sees fit. This 
publication describes the state of the product at the time of publication, and may not reflect the 
product at all times in the future. Use and disclosure of this product is governed by a licensing 
agreement printed. No part of this product may be disclosed or otherwise made available without 
prior written authorization. 
 
MicroSurvey® is a Registered trademark of MicroSurvey Software Inc.  All other trade names or 
trademarks are gratefully acknowledged as belonging to their respective owners. 
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Contact Addresses and Phone Numbers 
 

 
 

Corporate Head Office 
 
MicroSurvey Software Inc. 
#205 – 3500 Carrington Road, 
Westbank, BC, V4T 3C1 
Canada 
 
Office Hours: 8am to 5pm Pacific Time.  
(Monday to Friday, except holidays) 
 
Sales & Technical Support 1-800-668-3312 
International Voice: +1-250-707-0000 
Fax: +1-250-707-0150 
 
 
 
 

Eastern Technical Support Office 
 
MicroSurvey Software Inc. 
3427 Hwy. #17 East 
Corbeil, Ontario, P0H 1K0 
Canada 
 
Office Hours: 8:30am to 5:00pm Eastern Time.  
(Monday to Friday, except holidays) 
Technical Support Number: 1-800-668-3312 
International Voice: +1-250-707-0000 

 

 

Electronic Contacts 
 
Internet web-site - http://www.microsurvey.com  
 
Helpdesk - http://www.microsurvey.com/helpdesk/ 
 
General Information - info@microsurvey.com 
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Contacting MicroSurvey for Technical Support 
 
Fast, up to date Technical Support is available at any time to customers in the MicroSurvey 
Helpdesk at http://www.microsurvey.com/support/ 
 

 
There you have the option of using the Search Window, browsing Troubleshooter, Downloads 
and Knowledgebase articles or Submitting a Ticket to request help: 

 

Self Support (via the Internet): 
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Paid Tech Support: 
If your department has a current tech support maintenance contract you can contact MicroSurvey 
Tech Support by submitting a ticket: 

 
-if it is your first time submitting a ticket, view these movies for a quick guide: 

 
 
 
 
As you are entering your 
question Helpdesk will 
suggest articles which 
may answer your 
question immediately: 
 

If you are unable to access the internet please phone for tech support. 
 
Before calling for Tech Support, please review the information below:   
 
The following information explains how to prepare for your call so that your inquiry can be 
answered promptly and accurately.  Take a few minutes before you place your call to check the 
printed documentation and the on-line help files to see if the answer is already at your disposal. 
Remember that there are several tutorials and movie files that can also help explain some topics..  
If they do not help you then when you call please have the following information available if 
requested. Computer brand and model, CPU type and clock speed, amount of RAM and hard 
drive space free, other hardware attached to the computer such as plotters and digitizers, version 
of the program, operating system and version, whether or not you have a support contract. 
 
Please make sure that you have all the steps you completed prior to your problem and can 
explain them to the technical support representative.  We may ask that you forward a copy of 
your data to us if we can not identify the problem immediately. 
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Available Support Products: 
Introductory Support 

 
As is the MicroSurvey standard, MicroSurvey CAD 2010 includes a 90 day free support period.  
Support is available Monday to Friday except holidays in two times zones noted above:  To reach 
a technical support specialist, use the phone number listed under “Contact Addresses and Phone 
Numbers”. 
 
A support manager or designated alternate will have access to expedited telephone support.  
 
*  This support is not intended to be a substitute for qualified training, which is also available 
though our office.     
 

Free Web Based Support 

 
Web access to our support section which includes over 100 on-line training movies, technical tips, 
notes, and files is free with MicroSurvey products. Our web site is continually enhanced to 
provide new answers to commonly asked questions. We post free incremental updates, letting 
you stay up to date with the software version you are running. 
 

Maintenance Subscription Support Program 

• 1 year term includes Version Upgrades with significant enhancements plus critical service 
packs.  

• Electronic Help Desk Support (Available 24x7)  

• Telephone Support (available from 8:30 AM Eastern time until 8:00PM Eastern (through 
our Western office) ) 

• Free email updates to advise of any updates and improvements.  

• Call MicroSurvey's toll free number if you wish to purchase maintenance 800-668-3312 or 
purchase on line at:  http://store.microsurveysales.com/surveysupport.html.  

 
Why did MicroSurvey Switch to Annual Maintenance Plans? 
 
Like many software companies, whether they produce CAD programs like AutoCAD or 
accounting programs like Quickbooks, MicroSurvey has abolished standard upgrades for an 
annual maintenace plan. Here at MicroSurvey we pay for maintenance on a number of software 
programs like IBM Purify, Quotewerks, Quickbooks, Codebase, Stingray, Visual Studio, ACT, and 
many more.  
 
Why MicroSurvey CAD?  
 
Switching to the IntelliCAD platform for our software line has changed many of the opportunities 
for both MicroSurvey as a company and you, our customer. The IntelliCAD Technology 
Consortium (ITC) is a non-profit organization that is dedicated to one task - the creation of a 
Powerful, flexible CAD engine for its members. As a member, MicroSurvey receives many more 
updates on a more regular basis than in previous years. This gives us an ability to release 
updates more frequently. 
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In the past (before we went to maintenance) MicroSurvey had to accumulate both internal and 
external improvements, and bug fixes, and assemble them into an 'upgrade'. These upgrades 
appeared between 18 months and 30 months after the last release. Intermediate Service Packs 
had some critical bug fixes, but we could not add new features. These had to be saved for the 
upgrades. This means that we put significant improvements on our shelf for months. In 
addition, since bug fixes are often in the middle of code that we have updated, we have to shelve 
the bug fixes until the next upgrade. This was bad for you, and bad for us. We do not like our 
customers using code that has bugs, but as a software company it was impossible for us to 
release everything as it was done - for free. That would be unsustainable for us as a company.  
 
Here is a less abstract example:  
 
The ITC released 6.6 while we were building MicroSurvey CAD 2010. This release contain well 
over 1,000 bug fixes. The ITC's ability to find bugs has grown almost exponentially as they have 
added an incredibly sophisticated, automated testing system. The ITC is performing almost 1 
million test runs per day on the code. They have over 50,000 drawings they open and save daily. 
They do graphic file comparisons using automated bitmap file comparisons. MicroSurvey had to 
sit on these updates and accumulate them into our upgrade. In addition to this, MicroSurvey built 
its own updates including an entirely new surveying database system, and a completely new 
rendering and viewing engine. These updates required surgery deep inside of IntelliCAD, so they 
held up releasing bug fixes.  
 
In the next year, the ITC has scheduled new updates  
 
That will add more to the user interface. More importantly, a few years ago the ITC started on a 
complete, from the ground up, rewrite of IntelliCAD. This new CAD engine, which will arrive late in 
2009 or early 2010, should show significant performance improvements over the current version. 
With the maintenance system MicroSurvey has no need to sit on updates. We will still have new 
versions, but they will be available to maintenance plan customers immediately. Customers not 
on maintenance who decide to wait will be required to purchase all the years of missing 
maintence to get the new version. So, it makes no sense to wait. Take full advantage of the 
maintenance now rather than get billed for missing years. As a company, MicroSurvey has had to 
do that with some of the software products that we use internally, and it is much less enjoyable. I 
sign the checks, so I have felt the pain.  
 
Once you are on maintenance, your annual cost for MicroSurvey software is known.  
 
There are no surprises, no extra budget amounts that are unexpected. The maintenance fee will 
be lower than the cost of a normal upgrade, because it helps both you and us to maintain our 
business in an orderly manner. We are passing on the savings and stability to you, our customer. 
  
 

Training 
 
MicroSurvey Software Inc. can provide training to you, in your office or in a classroom situation 
(where facilities and numbers allow). MicroSurvey also has its own 16 seat classroom in our head 
office location and runs courses periodically at this beautiful location. 
 
MicroSurvey has training staff that will travel to almost anywhere and provide you with the 
professional skills you require to operate your MicroSurvey CAD 2010 program.  Please feel free 
to call and ask for a quotation or inquire about potential classroom situations.  
 
Your local dealer may also be able to setup or arrange a training session for you.  Contact our 
head office for more information about training. 
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Getting Started 
Hardware Requirements 

 
MicroSurvey CAD 2010 operates entirely within Windows, and has no hardware requirements 
over and above those of Windows itself except as noted below. We suggest the following basic 
system as a minimum for efficient operation: 
 

• Modern processor – the faster the better! 
• 512megabytes RAM (1GB or more if you are working in large drawings most of the time) 
• 1 Gigabyte of free hard disk space (1.5 GB if you wish to install all of the movies) 
• Video resolution set to 1024X768 or better (lower resolutions may result in part of the pull 

down menus running off the bottom of the screen)  
• Mouse, digitizing tablet or other pointing device 

 
In order to use the data collector communication features, your system will also need an external 
RS-232 serial port or a USB connection for best performance with MicroSurvey FieldGeniusTM. 
 
In order to get printed output, you will require a printer or plotter configured to work in your 
Windows environment.  We recommend obtaining the most up-to-date printer/plotter drivers off of 
the manufacturers Internet web site. 
 
Just like your system RAM, the more RAM your graphics card has, the faster it can render which 
results in faster, smoother playback.  Video cards that are optimized for video or games work best 
with our Render command. 
 
An important thing to note is that not all graphics cards have been tested with our rendering 
engine.  For a list of graphics cards that have been tested please visit the following website: 
http://developer.hoops3d.com/hoops/graphicscards.html 
 

Software Requirements 
 
MicroSurvey CAD 2010 is compatible with 32-bit editions of Microsoft Windows 2000, Microsoft 
Windows XP (SP2 or SP3), Microsoft Windows Vista (Release or SP1). 64-bit editions of 
Windows XP and Windows Vista have not been tested by MicroSurvey Software Inc.  
 
Note: Users must have Administrator’s rights to authorize MicroSurvey CAD 2010.     
 
When using a digitizing tablet you will require the current WINTAB driver for your tablet, and it 
must be installed and configured in Windows. 
 
 

Installation instructions 
 
As with most software packages today, installing MicroSurvey CAD 2010 is a snap!  
 
After confirming that your system meets the hardware and software requirements above, insert 
the CD in your drive to begin the installation. Your CD may Auto Start as soon as the CD is 
placed in the drive and the drawer is closed but if not, go to your Windows Start button, select 
Run and type d:\setup at the command prompt (assuming your CD-ROM drive is D). Choose the 
button of the action you want to take.  Follow the prompts, clicking Next to continue from step to 
step. 
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MicroSurvey CAD 2010 Initial Startup 
 
MicroSurvey CAD 2010, like other MicroSurvey Software Inc. products, is marketed in the form of 
a "Convertible Demo", which lets you try out all its functions without buying a copy. You can 
obtain a copy of the entire package by mail for a nominal shipping and handling fee; we also 
encourage you to redistribute copies to anyone in complete and unaltered form. This copy will be 
fully functional in every way but will shut down after 30 days. 
 
If you decide to purchase the system, you can convert it to full operation by contacting 
MicroSurvey Software or an authorized dealer and arranging to purchase a USB Key license.   
 
When you initially start up the program, you will see the following dialogue box:  
 
 

The program will be fully functional for 30 
days during the trial period.  You have the 
option of running the program in 30 Day 
Trial mode to see how the program works.   
 
If you have already received your USB key 
you will want to follow the steps in 
“Registering MicroSurvey CAD 2010” to run 
your program in fully registered mode. 
 

 

License Options 
MicroSurvey Software is registered by activating a USB License key.  USB License Keys allow us 
to provide you with more license flexibility compared to password based activation.   
 
Whenever you start your software and no USB License Key or Network License Server is found, 
you will see the MicroSurvey Licensing Options dialog. 
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Evaluation: 
Demo Mode 

If you haven't purchased anything and want to evaluate our software, you can do so without a 
USB License Key.  Our software will run in a 30 day demo mode which begins the moment you 
run the software for the first time. 
 
To activate Demo Mode, press the Run in 30 Day Trial Mode button on the Licensing Options 
dialog.  This dialog will appear when you run the software. 
 
When in demo mode the program will function like a fully registered version, everything is 100% 
functional, including saving and printing. 
 

Expired Mode 
Your demo time period is 30 days, and begins the first time the software is run.  After 30 days the 
program will automatically switch to an Expired state.  Once the program is expired, you can still 
open existing projects but Saving and Printing is disabled.  Once expired, the only way to 
continue using your software is to purchase it. 
 

Purchased Licenses: 
When you purchase our software, you can purchase it as; 
 

a) Standalone 
 One license per key. 

 
The USB key must be inserted into a USB port on this specific computer during the entire time 
the program is in use.  Removal of the USB key will cause the program to warn you and then if 
the key is not replaced, exit abruptly (saving your drawing as it exits). 
 

b) Network Version  
Multiple licenses per key. 

 
The Network version will require the installation of a Network License program on the server.  
Then the USB key needs to be on a computer on the network that everyone has rights to.  The 
license is then released to the appropriate machine and the counter is decremented by one.  
When the user exits the program the counter is incremented by one again.  Only the number of 
licenses activated on the USB key can be used at any one time, but as a user exits the program, 
freeing up a license, another user can then use that license. 
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Registering MicroSurvey CAD 2010 
Activating Your USB Key 

 
Critical Note: The USB license is small, sturdy and convenient.  BUT it contains the only version 
of your MicroSurvey CAD 2010 License.  If the key is somehow damaged it can be exchanged 
without the purchase of a new license but if the key is lost or stolen it CANNOT BE REPLACED 
and must be repurchased at full current retail pricing!  
 
If possible, insure this key against loss or theft. 
 
 
 

 

Each License Key has a unique serial number that we 
store on our MicroSurvey License Server.  Our 
license database contains the following information 
about your key: 

• Which company the license key belongs to. 

• Which products the key is allowed to run. 

• How many copies of each product is allowed 
to run. 

• What version of a product you are allowed to 
upgrade to. 

• The expiration date of your support and 
software subscription plan.  

 
Activating Your Key (Method 1)  

Using the Internet on the PC with MicroSurvey CAD installed on it: 
 
There are two ways you can activate your key with the following method being the easiest.  
Method 1 will most likely be the method you use because most of our customers have internet 
access directly on the computer that the software will be run on.   
Before you can activate your key you will need to ensure you have: 

• Internet Access -  To activate your key, you will need internet access on the computer 
you will be activating the key from.  Once activated, you do not need internet access. 

• Microsurvey CAD 2010 Installed - When you install MicroSurvey CAD 2010, a special 
program called the License Manager is also automatically installed.  You need the 
License Manager to activate your key. 

• USB License Key - You will need to have the USB License Key that was shipped with 
your purchase. 

• USB Port - You will need a free USB port either on the computer or via a USB Hub. 

1. Insert your USB License Key in any available USB port on your computer. 

2. Go to windows Start | Programs | MicroSurvey CAD 2010 and run the License Manager 
program: 
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3. The Key Maintenance program will display the information about what products are licensed 
for the key, how many licenses you are allowed to run, and the expire date of your support 
and software subscription plan. 

4. On the MicroSurvey License Key Maintenance program, select the “Update Key with New 
Information” button. 

 

On the MicroSurvey 
License Key 
Maintenance 
program, select the 
“Update Key with 
New Information” 
button. 

 

 
5. If successful, you will see a message “Key successfully updated”. 

 

 
If 
successful, 
you will 
see a 
message 
indicating 
that the 
key was 
updated. 
 

 

6. Pick the Exit button and now you can run the MicroSurvey CAD program directly. 
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Activating Your Key (Method 2) 
Using the Internet on a different PC: 

 
Method 2 should only be used if you don't have internet access on the computer you will be 
running your software on.  Use this method if you need to activate your key without installing 
MicroSurvey software. 
 
Before you can activate your key you will need to ensure you have: 

• Another computer that has Internet access.  You will need to be logged in as an 
administrator.  Once the USB key has been activated on this computer, it can be moved 
back to the computer running MicroSurvey CAD 2010 and you will not need internet 
access again. 

• Product CD - You will need the original product CD that was shipped to you with the 
purchase of your software. 

• USB License Key - You will need to have the USB License Key that was shipped with 
your purchase. 

• USB Port - You will need a free USB. 

1. Insert your Product CD in your CDROM drive. 

2. On the startup install screen, press Exit:  

 

3. Use Windows Explorer to manually browse to the following directory on the CD:  USB 
Activation | License Manager Install 

 
 

4. In the License Manager Install directory, run the USBLicenseManager.exe program.  (You 
must be logged in as an Administrator to complete this task) 
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5. After the installation completes, you can insert the USB License Key in any available USB 
port on your computer. 

6. Go to Start | Programs | MicroSurvey | USB License Manager and start the License Manager 
program. 

7. The Key Maintenance program will display the information about what products are licensed 
for the key, how many licenses you are allowed to run, and the expire date of your support 
and software subscription plan. 

8. On the MicroSurvey License Key Maintenance program, select the “Update Key with New 
Information” button. 

 

On the MicroSurvey 
License Key 
Maintenance 
program, select the 
“Update Key with 
New Information” 
button. 

 

 

9. If successful, you will see a message “Key successfully updated”.  

 

 
If 
successful, 
you will 
see a 
message 
indicating 
that the 
key was 
updated. 
 

 
10. Pick the Exit button. 

11. After the activation is complete, you can insert the USB License Key in any available USB 
port on the computer with MicroSurvey CAD installed on it and start the program. 
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Running MicroSurvey CAD 2010 with the USB Key: 
  

The Licensing routine will check for 
a USB key as soon as it is run: 
 
If you have a Standalone License 
ensure that the USB key has been 
inserted.  If you see the message at 
the top of the dialog on the left, 
insert the key and pick “Try Local 
USB Key Again”, if available. 
 
If you have a Network License 
ensure that the USB key has been 
inserted in the Server and that the 
correct Server name is listed. Pick 
on “Scan Servers For USB Key”, if 
necessary. 
 

 

Running MicroSurvey CAD 2010 with a USB Key that was not updated: 
 

 
 
If you are upgrading from a 
previous version of MicroSurvey 
CAD that used a USB key, you may 
see a message like what is shown 
in the top portion of the dialog to 
the left. 
 
If this is the case, then you will 
need to first run the License 
Manager and update your USB key 
to allow it to run this new version. 
 
See how to use the License 
Manager in the pages above. 

 

General License Notes 
 
With MicroSurvey CAD 2010 you can easily transfer the license to another PC.  Install 
MicroSurvey CAD 2010 as a convertible demo on the new computer and insert your USB License 
Key.  
 
You can also install as many copies of MicroSurvey CAD 2010 as you like.  Install it at home, at 
the office, on your laptop or where ever you need to use it.  All that matters is that if you want to 
use the program, you must have your USB Key License with you. 
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About the Program 
How MicroSurvey CAD 2010 Works 

 
MicroSurvey CAD 2010 creates a database that contains connectivity information, coordinate 
locations, descriptions, traverses, bearings, and distances. The program tracks the entities stored 
in the CAD drawing by their handle numbers. Many files are created to store this information.  
 
In order to limit the number of files you need to work with, we combine the data files into one file 
when you close the MicroSurvey CAD 2010 job. The database is stored in a file with the 
extension .MSZ.  This file is stored wherever your CAD drawing is stored.  
 
The MSZ file is expanded into a directory that has the same name as your job with the extension 
.MSJ. If you are running MicroSurvey CAD 2010 and you look in the directory where your job is 
located, using My Computer, you will see this .MSJ subdirectory.  When you close the 
MicroSurvey CAD 2010 job, by exiting or closing the drawing, then the files will be automatically 
compressed into one file, and the directory will be removed. While you have the job open, the 
original .MSZ file is rename to .MBZ and it serves as an emergency backup file.  
 
MicroSurvey CAD 2010 has an Automatic backup timer that will save the drawing (but not the 
database) regularly, to a temporary folder.  
 
In the event that the .MSZ file cannot be opened, the system will automatically attempt to open 
the .MBZ file. If neither file can be opened (very unlikely), then the system can still reconstruct the 
coordinate database and the connectivity database directly from information we store in the 
drawing.   
 
If you have only the drawing created in MicroSurvey CAD 2010 and no database for whatever 
reason, we can still recover coordinates from the drawing automatically upon opening the DWG 
file.  This can be accomplished by running the Audit database command.  See the on-line help for 
more information.   
 

Workflow 
 
This summary is intended to provide an introduction to users who are not familiar with 
MicroSurvey CAD 2010 and outlines the steps necessary to prepare a survey drawing. 
  
Generally you will be starting with data from a data collector, from field notes, or from direct 
COGO data entry. You may also extract data from existing CAD drawings.   
 
When you first start MicroSurvey CAD 2010 you must either open an existing drawing (DWG, or 
DXF file) or start a new one. Opening an existing drawing will automatically open and link to the 
associated MicroSurvey CAD 2010 coordinate database (.MSZ file). If you start a new drawing, a 
new MicroSurvey CAD 2010 database file will be automatically created.  
 
On new projects or when you open existing projects, you will be shown the Main Job Defaults. 
You should fill out the dialog box and set up the basic job information and scale factors.  Next you 
will need to set the System Toggles to choices appropriate to the job.  Where you start next 
depends on the data source. Most options can now be found on the Assistant or in the 
MicroSurvey pull down menus.   
 
For data collectors you will either download directly from the data collector using the choices on 
the Data Collector Communication menu or reading a file from the data collector using the 
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choices on the MsTraverse | Download Data Collector menu.  For field note entry you will use the 
Enter Traverse command on the MsTraverse | Traverse Entry / Editing menu.  For manually 
entered COGO data, you will use the COGO command from the MsCOGO menu. (you can 
simply type COGO if you wish as a short cut)  For point, line and curve data in a pre-existing CAD 
drawing, you will use the Auto Add Points to Objects command in the MsPoints menu.   
 
When you enter a traverse in MicroSurvey CAD 2010, either by downloading a data collector or 
by manually typing in the data, the program creates a traverse database.  Each traverse is 
contained in a separate database. The databases are stored in the project directory when 
MicroSurvey CAD 2010 is loaded and running, and they are automatically compressed into the 
.MSZ file when MicroSurvey CAD 2010 is unloaded.   
 
There is a set order that you should use when working with raw data information in 
MicroSurvey CAD 2010 (once a job is open): 
 

1) Manually enter, load from a file or download the data into the traverse file. 
 

2) If you are entering the data manually, and the Auto Coordinate toggle is ON, then 
points will be coordinated and drawn onto the MicroSurvey screen as you enter the 
data. If you download the data from a data collector, any coordinates in the ASCII file 
will be entered immediately in the coordinate database. The raw data shots read in 
from the data collector ASCII file are NOT processed into coordinates until you select 
Re-coordinate Traverse. 
 

3) Edit the raw data to correct any known errors by selecting MsTraverse | Active 
Traverse Editor. 
 

4) Enter any starting setup and backsight coordinates into the coordinate database 
before you attempt to coordinate the traverse. Use Store and Edit Coordinates on the 
MsPoints menu. 
 

5) Select MsTraverse | Traverse Calculations | Re-coordinate Traverse. This is the 
program that analyzes the raw data and computes the coordinates for all the raw 
data shots taken in the field. 
 

6) Use the MsPoints | Active Coordinate Editor to view the points. Examine the 
MicroSurvey drawing for errors. 
 

7) Correct errors using MsTraverse | Active Traverse Editor and Re-coordinate the 
traverse.  When you run Re-coordinate traverse on a traverse that has already been 
coordinated, you will trigger a point protection alert for each point processed.  To 
avoid this, turn off Point Protection in System Toggles, then the entire traverse will 
then be process without interruption. 
 

8) To see the line work for the traverse go to the MsTraverse | Traverse Entry / Editing | 
Show Traverse Graphically command. 
 

9) Use the MsTraverse | Traverse Calculations | Compute Closure option to analyze the 
closure of the traverse. 
 

10) You may balance the traverse using one of several options, Angle Balance, Transit 
Balance, Crandall's, Least Squares, or Compass Balance. See Traverse Balancing in 
the on-line help for details. 
 

11) If you detect an error after balancing, you can revert back to the original or edited 
traverse and re-coordinate it again starting at step  
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For more examples of MicroSurvey workflow, please see the Tutorials 

 

Files types used by MicroSurvey CAD 2010 
 
An outline for how MicroSurvey CAD 2010 saves your drawings. 
 
The default folder name to save your jobs in C:\Documents and Settings\USER\My 
Documents\MicroSurvey\MSCAD\2010\Jobs2010. (Where \USER\ is your user login name) Then 
create a new one for 2011, etc. as desired.  We do NOT recommend that you place your jobs 
directly in our MSCAD 2010 program folder or in a sub folder under MSCAD 2010.  Also - try and 
keep your folder names simple and not too many levels deep (Microsoft forces us to make them 
deep enough already).  The job name should also be kept simple.  Under this folder you can have 
many jobs, each with its own name.  When you start a new job or open an existing job, there are 
several files created automatically on the hard drive in the folder you selected. 
 
Below is an example of what files are created by MicroSurvey - using the job “EXAMPLE”. 
 
Every MSCAD project contains four important files, a drawing file, a database file, a backup 
drawing file and a backup database file.  

  
 
 
Main files saved by MSCAD 
 

Drawing File  EXAMPLE.DWG 
Database File  EXAMPLE.MSZ 
 
Backup of Drawing file  EXAMPLE.BAK 
Backup of Database file  EXAMPLE.MBZ 

 
Temporary Folder                 <dir> EXAMPLE.MSJ 

 
 
When you create a new project, MicroSurvey creates a database that contains all survey related 
data which can include connectivity information, coordinate locations, traverses, bearings and 
distances.   
 
In order to limit the number of files you need to work with, we combine the data 
files into one file when you close MSCAD.  The database has an extension of 
.MSZ and is stored wherever your CAD drawing is located.  When you’re 
working on your project, the MSZ file is expanded into a directory that has the 
same name as your job with the extension .MSJ.  Note that when you save or 
close your project, the MSJ folder will be compressed back into the MSZ file. 
  

 If sending 
files to another 
computer or 
MicroSurvey 
user, make sure 
to send both the 
Drawing and 
Database files. 

 Do 
not store or 
edit files 
found in 
the 
temporary 
.msj folder! 
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Some of the sample files contained in the temporary .MSJ folder 
 
When the Job is opened, the Drawing file goes into your computer memory, and the Database file 
is opened into a temporary folder.  The temporary folder has the same name as the JOB but has 
an extension of MSJ attached to it. 
 
You should not touch this folder and nothing should be placed in here except via the automated 
routines in our program.  We place this temporary MSJ folder in the same location on the hard 
drive as the job. This is why you cannot open a job from your floppy drive, CD drive, Thumb 
Drive (etc.) as it is too slow and does not have enough space, or ability to work live! 
 
When you save the job, the contents of this folder are compressed and saved into the MSZ file. If 
you exit the program the MSJ folder is erased, along with everything in the folder, so you no 
longer have direct access to anything in there. This is why you should not place anything in this 
folder yourself.   
 
Each time you save the job you are taking the current information in memory and saving it to the 
DWG file.  Then we take the current contents of the MSJ folder and save it to the MSZ file.  At the 
same time, if a DWG and MSZ file already exist then we rename the copy already on the hard 
drive.  The DWG file becomes the BAK file, and the MSZ file becomes the MBZ file.  This way 
you have backups of your work in case you need them.  If a BAK file and MBZ file already exist 
then they are simply replaced by the newer copy. 
 
As you work through a job you will create other files as well.  The RTF file (log file) is saved 
automatically in the same folder as the DWG file.  This file maintains a record of the survey 
commands run with their output.  There is a toggle to control this file as well as the ability to blank 
the file.   
 
If you do any work in the Modeling menu and you decide to save your surfaces then you will 
create a QSB file.  We suggest you save it in the same folder as the DWG file as well.  This QSB 
file is not automatically saved and must be done manually - also for loading it must be done 
manually each time you wish to use it in the job. 

Backup Files 
 
Each time you save the job you are taking the current information in memory and saving it to the 
DWG file. Then we take the current contents of the MSJ folder and save it to the MSZ file. At the 
same time, if a DWG and MSZ file already exist then we rename the copy already on the hard 
drive. The DWG file becomes the BAK file, and the MSZ file becomes the MBZ file. 
 
This way you have backups of your work in case you need them. If a BAK file and MBZ file 
already exist then they are simply replaced by the newer copy. 
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Autosave 
 
When AutoSave is enabled, the program creates a copy of your drawing. The file is saved in the 
folder specified in Options | Paths/Files for Temporary Files, with the file extension specified in 
the AutoSave Drawing Extension box (by default, .SV$).  The MSZ file is not backed up during 
this command.  A second AutoSave will take the existing SV$ and rename it to BAK and then 
save the current SV$.  Windows may need to be set for you to browse to or search for files inside 
this folder location.  By default this folder is often set to be hidden by Windows. 
 

MSBACKUP 

Use this command to create a backup copy of the last saved version of your drawing and 
database file.  It might be a good idea to run the Qsave command first.  A new directory named 
MicroSurvey Backup will be created automatically in the current project directory.  It will then 
create a copy of the drawing and database to this location and rename the files starting at 
"_bak1".  Subsequent backups will be saved with incrementing backup numbers. 

You also have the option of adding a note for the backup log file,  

  

which can also be viewed after the backup. 

 
The backup log file is viewed in Notepad and can be printed if desired 

 

The original project isn't moved or altered in any way.  After the backup is complete, the original 
project will still be open so you can continue working on it. 
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Other Files Created by MSCAD 
 
Depending on the routine or function being used, MSCAD can create other important files, some 
of which are listed below. 
 
Log File  .RTF 
Helmert’s Transformation  .BIN 
Modeling Surfaces  .QSB 
Horizontal Alignments  .HRZ 
Vertical Alignments  .VRT 
Cross-Section template  .TMP 
MS Batch COGO  .BCH 
Depending upon the routine you run, you can also manually add a file extension to some files. 
(ASCII and Data Collector outputs are good examples of these) 
 
If you download a data collector you may have a Raw data file or a Coordinate file.  You must tell 
us where to save these files on the hard drive and in some cases even what to call them.   
 
Depending upon what type of collector you are using, the file names may be sent directly from the 
collector to our program.  Other brands will require you to provide the name and extension.  If you 
are providing the name then be sure that it reflects your job name, is unique and has an 
extension on it. 
 
Suggested extensions might be RAW for raw data files and COR or TXT or ASC for coordinate 
files.  (TDS collectors use RW5 for raw files and CR5 for coordinate files, and both use the name 
stored in the collector automatically)  Or course there are many other files that you can create 
with MicroSurvey, they can range from Report files and closure files, to ASCII exported files and 
upload collector files, and even Legal Descriptions.  You can name these anything you desire but 
we recommend that the naming structure be consistent and use appropriate extensions, and 
always keep the files together so you know where the files are.  We allow you a lot of flexibility 
but you have the ultimate control and if you do not know how to work in Windows to create the 
correct folders then you may wish to receive some training in this area before jumping in too 
deep. 
 
Note that for MicroSurvey CAD 2010 you can set the program to store all drawing files in DWG or 
DXF format from version 2.5 – version 2007/2008, as appropriate. 
 

Program User Interface 
The desktop contains a series of standard elements. These are the menu bar, the toolbars, the 
properties bar, and the status bar. 

In addition, the desktop may also contain several toolbars. 

The following picture shows a possible layout of the desktop, showing the Drawing Window, a 
sample of Toolbars, the pull down Menus, Hot Toggles, Active Coordinate Editor and our new 3D 
Viewer for Rendering.  See the on-line help system for more details on each section.  

This sample drawing shows a simple AutoRoute with a vertical profile (containing road and sewer 
information), cross sections, sewer table and a raster image under the plan view of the survey.  
The 3D Render window shows the surface tin being modeled in 3D.  The Active Drawing 
Technology window shows the list of coordinates in the project. 
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Pull down Menus 
 

The pull down menus are setup to group like commands together.  The menus starting with Ms 
are generally survey related commands, and the others are generally CAD related commands.  
(There may be some cross over between the two grouping categories) 
 

Command Line 
 
The command line can be placed at the top of the screen (below the menu bar), or at the bottom 
of the screen (above the status line).  It can also be placed pretty much anywhere else you 
desire, on the screen as a floating toolbar. 
 

Properties 
 

 
 
The property bar can be turned on or off. We recommend you turn it on.  It allows you to control 
layering and related options. 
 

Status Bar 
 

 
The status bar can be turned on or off. We recommend you leave it on.  It presents coordinate or 
direction and distance data, along with comments on what commands are being picked.  It also 
has command setting options in the far right. 
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Customizing Toolbars 
 

 
 
The toolbars assemble buttons that represent a common set of commands, or sequence of 
commands.   There is a training movie showing how they can be customized. 
 

Active Drawing Technology  
 
This spreadsheet type dialog can display the Active Coordinate Editor, the Active Traverse Editor 
and the Active Batch Editor. 
 

3D Viewer 
 
This floating window allows you to see your drawing in a rendered 3D perspective, which you 
control via the mouse. 
 

Help System 
 
The help system is continually updated to keep current with all the advancements and new 
commands that are added on a regular basis.  The help file also has Tutorials, Important Phone 
Numbers, Copyright Information, and Much more.  Be sure to look through the whole help file as 
it will always be more current and comprehensive than any printed manuals. 
 

A few tips about using Help: 
 
You can find Help using any one of these 3 methods: 
 

1. By clicking on the HELP button available on most dialogs within MicroSurvey CAD 
2010. This will take you to the help topic on the command currently in use. 

2. Quick tips are available on most dialogs within MicroSurvey CAD 2010 by using the 
What's This? Help.  

3. Access the Help System from the top of the Help menu or using the F1 key.  If you 
have highlighted a menu item, press F1 to jump to it in the on-line help. 

 
Have a look at the next image. The Help is arranged in the same basic order as the Menus.  
 

• Notice that the topic for COGO is displayed. If you had located this topic using the 
Index or Search options, you should flip to the Contents option to locate the 
command in the menu system. 
 

• Notice that the keyboard command is shown where possible as well as the 
corresponding toolbar button. 
 

• The Back button will take you to the last page viewed and the forward and back 
arrows help you to navigate through the Help system in topic order as shown in the 
table of contents. 
 

• Always look for the vertical scroll bar on the far right hand side. Its’ presence 
indicates that there is more information below that is not currently visible. Some 
topics are several pages long! 
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What's This? Help  

The little  in the corner of the dialog box allows you to pick it then pick the portion of the dialog 
that you want help on while running the command. 
 
Use this to find out about any portion of the dialog box on screen. 
 
MicroSurvey Assistant 

 
These dialog style menus are designed to assist you in developing a job from first principles to 
completed survey drawing, with minimal knowledge by the user.  
 
The Assistant can be started by going to the MsTools menu | MicroSurvey Assistant or by picking 

this button  on the MS Main Control toolbar 
 

Assistant Main Menu 
 
The main menu is structured so that no matter what survey related command you have to do to 
start a job, you should be able to do it directly from here.  
 
As you move your mouse around on the assistant, you will see different pictures appear for each 
of the buttons.  They are there to help you remember what each button will do for you.  Picking on 
one of the buttons will take you to a second level of menus that provide more programs.  
Investigate them all so you will know where to find what you need. 
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Assistant - Set Program Defaults 
  

Use this dialog to modify the Program 
Defaults. 
 
You can modify the Main Job Defaults 
under the General button.  The Toggles 
are also available to you from this 
dialog, along with all the other defaults 
used to setup such things as distances, 
elevations, point numbers, etc.  The 
CAD Settings and Drawing Units will 
display the appropriate options allowing 
you to set the working units, grid, snap, 
point style, OSNAPs, trim radius, 
highlighting options, mirror text options, 
and a whole lot more.   
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Assistant – FieldGenius Tools 
 

MicroSurvey’s 
FieldGenius line of data 
collectors has a super 
productive and easy to 
use interface. Our 
extensive experience 
with a variety of 
manufacturer’s data 
collectors ensured that 
when we built an 
interface, it would be 
better than anything on 
the market. Our 
MicroSurvey Transfer 
Program, intergraded 
with ActiveSync, makes 
data transfer and import 
as painless as possible. 

 

Assistant - Send/Receive Data from Data Collector 
 

 
This short menu assists you if you are 
downloading a file from your serial  data 
collector to the computer or uploading a 
file from the computer to your data 
collector. 

 

Assistant - Import ASCII File or Data Collector File 
  

Another method of importing point data 
into MicroSurvey CAD 2010 is via an 
ASCII file.  This file would have 
information like; Point Numbers, 
Northings, Eastings, Elevations, 
Descriptions, each describing a point, 
and in one of several different formats 
in a text file known as an ASCII file. 
 
You can also read a data collector file 
that you downloaded previously, 
incorporating the data into your job. 
 
Several other tools have been added to 
this menu to allow you to join points by 
linework in an automated method.   
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Assistant - Traverse Entry / Edit / Adjustment 
 

 
This menu option allows you 
to manually enter, edit, list, re-
coordinate, or show a 
traverse.  It also allows you to 
compute closures and balance 
the traverse. 
 
Data collector files are also 
considered to be traverses 
and therefore you have the 
ability to manipulate those 
files as well.  Especially useful 
for the data collector file is the 
Re-coordinate traverse option 
which is required to calculate 
coordinates from the original 
Raw data saved in your data 
collector files. 

 

Assistant – Grouping / Graphical Data Editor 
 
 
This option actually starts the command 
rather than bring up another dialog with 
sub-options on it. 

 

Assistant – Use COGO / Calculating Programs 
 

Here are the shortcuts used by 
almost everyone.  COGO is one of 
the most used portions of 
MicroSurvey CAD 2010.  Working 
with lines and curves, generating 
streets from centerlines, and then 
taking those streets and adding 
blocks and lots to create a 
subdivision.  Finally this section 
allows you to take the lots and 
place houses on them, with 
labeling of the lot numbers and 
areas.   
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Assistant – Digital Terrain Model / Contouring / Volumes 
 

 
For the customers that need 
to take their survey drawings 
a step further and create 
surfaces from the point and 
line data, we have made the 
transition to the Modeling 
program as seamless as 
possible.  The more 
common activities of 
creating Surfaces, TINs, 
Contours, and continuing 
further to calculate volumes 
between multiple surfaces, 
are all made available to you 
here along with many other 
options. 

 

Assistant - 3D Design Programs 
  

 
This menu is used for the 
more advanced design 
sections of MicroSurvey 
CAD 2008. These routines 
are explained in detail in 
the Help system. 

 

Assistant - Label Drawing 
  

 
This menu is a short cut to all 
of your text and labeling 
routines.  Many of the 
Toolboxes can be accessed 
here to help make rapid 
labeling possible.  Other 
routines such as line and 
curve tables and area 
calculations are added to 
assist you.  The toolboxes, 
display many options and can 
be left on the screen for future 
usage.   
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Data Collector Tutorial 
 
 
Because of the size and complexity of this tutorial we have broken it down into 12 smaller steps 
to make it easier for you to follow. 
 
Step 1) Starting the Job 
 
Step 2) Importing a Data Collector File 
 
Step 3) Viewing the Drawing 
 
Step 4) Line Connection – Z-coding 
 
Step 5) Create Surfaces 
 
Step 6) 3D Viewing and Advanced Rendering 
 
Step 7) Cleanup of Screen 
 
Step 8) Quick Contours 
 
Step 9) Setting up a Boundary 
 
Step 10) Final Contours 
 
Step 11) Labeling Contours  
 
Step 12) Saving Your Work 
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Step 1) Starting the Job 
 
In this introductory tutorial we will load a data collector file and annotate the points, connect the 
break lines, then build a contoured topographic model of the surveyed site.  We will start with a 
new empty drawing and project and build everything from scratch. 
 
To begin, start a new drawing by going to the File Menu and executing the Project Manager 
command. 
 
Pick the New button on the Project Manager: 
 

 
 

Then fill in the name of the job and call it SOKKIA.DWG,  
 



 

34  Getting Started in MicroSurvey CAD 2010 

 
 

Pick on the Save button. 
Next you will see the following dialog box. 
Set the scale and other settings as shown below. 
 

 
 

Pick on the OK button to continue. 

Step 2) Importing a Data Collector File 
 
To work from the MicroSurvey Assistant, Go to the MsTools menu | MicroSurvey Assistant. 
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From the assistant pick the Import ASCII File or Data Collector File button. 
 

              

 
 
 
Then from this dialog 
pick the Import Data 
Collector ASCII File 
button. 
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Now select the button that says Sokkia 20/22/24. 
 
You will then be presented with the Toggle Check dialog box to confirm that they are 
correct or to change them if required. 
 

 
 
Pick the OK button to continue. 
Next you will see the following dialog. 

 
 
If required, change to the C:\Documents and Settings\Glen\My 
Documents\MicroSurvey\MSCAD\2010\Jobs2010\Examples folder and pick on the file 
named SOKKIA.RAW. (where \Glen\ would be your login name) 
 
Then pick on the OPEN button to continue.  This is a Sokkia coordinate data collector 
file. 
 
Then you will see the following dialog box: 
 

 
 
Select New File, because this is a new traverse database.   
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Enter Sokkia as the new traverse name in the following dialog box (it may already 
default to this name, if so just accept it), and pick the SAVE button to continue. 
 

 
 
Fill in information about the job in the dialog box below and then pick the OK button. 
 

 
 
This collector file contains only coordinate information and therefore all the points are 
passed directly through to the database and screen. As the data points are loaded, you 
will see the data collector records scroll by in the text window, but because the view is 
not over the site, you don’t see anything until the end when the program automatically 
does a zoom extents for us.   
 
You will see this dialog box in the middle of the screen. 
 

 
 
Pick on NO 

 
 
And NO. 
 



 

38  Getting Started in MicroSurvey CAD 2010 

Then when the Assistant menus come back on screen – hit EXIT on each one until they 
are removed from screen and you are left with just the job on screen.  

 

 
 

Step 3) Viewing the Drawing 
 
(This step of the tutorial is to help show the points in the job in a view that will help you 
understand the program.  This entire step is not required when doing your own jobs later) 

 
You will see all of the labeled points from the job.  If you zoom in on a couple of points, they 
would look like this.  

 

 
 
(The zoom commands are typically docked on the left side of the screen but contain 
these buttons) 
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The annotation (text) is drawn at the current elevation (usually zero), but the points are 
drawn at their actual 3D elevation.  You can see this by looking at your drawing from an 
oblique view. 
 
Let’s set our drawing to an oblique view. Run the Preset Viewpoints… command, found 
in the View drop-down menu. You will see this dialog: 
 

 
 
Now press this button (this is the ISO View SW button): 
 

 
 
Then Press the OK button. 

 
You will see from this oblique view that the points are at their elevation towards the top of 
the screen and the annotation is at an elevation of zero.  
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Run the Preset Viewpoints… command again, found in the View drop-down menu.  
Now pick the Top View (Plan View) icon button found in the 3D View… command, to 
return to a normal view. 
 

 
 

 

Step 4) Line Connection – Z-coding 
We are going to connect points sharing the same descriptions, with 3D break lines, so 
let’s create a layer on which to place them.  Select the layers icon in the bottom left 
portion of the screen, as shown here. 
 

 
 
Make a new layer called "lines" and make it current as follows: 
 
The window opens to the Layers table.  Pick the New button at the top left end of the 
toolbar, and type in LINES as the new layer name.  Double click on the layer name 
LINES to make it the current layer.  The small blue check mark will be placed there to 
indicate the current layer.  Close the IntelliCAD Explorer window. 
 
           

 
 
From the MsTraverse pulldown menu, select AutoMAP System | Connect Points by 
XYZ,  and you will see 
 

 
 
We will be using these as break lines for our topographic surface, so pick the 3D Lines 
button.   
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You will see some linework being drawn on screen and then you will see the following 
dialog box. 
 

 
 
The data collector file in this example uses Z coding to allow for fast automatic 
connection of points with lines.  Normally, you would blank the description codes to 
remove the leading Z character, but for this demo, answer NO to blank description codes 
so you can see them. 
 
Now your screen should look like this.  The lines you see are in 3D, just like the points 
that were used to create the lines. 
 

 

 

Step 5) Create Surfaces 
 

Now you have points and break lines, which is all you need for a topo map and surface. 
We will extract the data from which to make our map by using the Data Extraction filters 
in the Modeling routines.  This allows us to be very specific on what we are using to 
create our surface.  You do not always need to use the filters but doing so allows you full 
control. 
 
Go to the MsModeling pulldown menu and pick on Configuration Settings. 
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This dialog will appear: 
 

 
 

Pick on the Data Extraction button and this dialog box comes up. 
 

 
 

Pick on the Filter by Entity button and then pick OK to continue, and OK again to exit 
the previous dialog. 
 
Next go to the MsModeling pulldown menu and select Extract from Drawing | Extract 
to Surface.  You will see the dialog box shown here.  Accept the surface name of 
Ground and pick the OK button to continue.   
 

 
 
Now you will be asked what it is you are picking to create your surface.  On this dialog 
pick POINT from the list – then pick the SELECT button and then the OK button to 
continue. 
 



 

Getting Started in MicroSurvey CAD 2010 43 

 
 
Next select the points, by windowing the entire drawing, or simply press ENTER and the 
routine will grab everything in the drawing automatically for you.  Don’t worry if you get 
the break lines too as we have told it to filter out just the points at this time.   
 
264 points total in surface.  

 
You have now placed all the points on the surface Ground.  Now we need to do the 
same thing with the breaklines. 

 
Pull down the MsModeling menu and select Extract from Drawing | Extract Breaks. 
This will show the following dialog box, similar to the one above.  
 

 
 
Pick OK to accept the surface name Ground as BOTH the points and breaklines must 
be on the same surface.   
 
Now you will see the following dialog box. 
 

 
 
Pick on the 
RESET button to 
see the complete 
list of filters. 
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Then pick on LINE, POLYLINE and LW Polyline, as shown below.  

 
 
Then pick on the SELECT button.  What you are doing is telling the routine that you no 
longer wish to pick points but now wish to pick lines and polylines to add them as 
breaklines to your surface. 
Then pick on the OK button to continue. 
 
Now you can select the breaklines by making a window around the drawing, or by simply 
pressing ENTER to select everything on screen.  Don’t worry if you get the points too as 
the filter will only use the 3D lines and polylines it finds. 
 

179 additional points added to current surface. 
 
Note: The order is important here.  Extract points first, then breaks.  This puts the 
extracted data into a surface named what you decide.  The default is GROUND.  We 
don’t see anything yet because we just created a surface in memory, but have not 
displayed it. 

 

Step 6) 3D Viewing and Advanced Rendering 
 

Most of the time you would just create and draw contours at this point, but we will take a 
two-minute side trip to explore basic site visualization in 3D. 
 
To start with, we are going to create and draw a TIN (Triangulated Irregular Network) 
representing the topography by selecting TIN from the MsModeling menu | TIN 
Create/Edit option, pressing return to select the <GROUND> surface and then 
answering D to Draw the surface (rather than the temporary Show) and press return 
twice to draw it as a polyface mesh entity with invisibility as NONE.  This is the 3D 
surface representing the points and breaks of the surface. 
 
Here is what you should now see. 
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The 3D TIN is now on screen, and we can use a new command called RENDER to look at is in 
full 3D.  Go to the View menu | Rendering | Render (or type in the command RENDER).  You will 
see a 3D Viewer window pop up on screen. 
 

  
 
This is where you can easily rotate the job in 3D to examine it from any direction you wish.  Use 
the left mouse button and double click in the middle of the surface, then use the left mouse button 
to spin the job around, by picking and holding the button while moving the mouse. 
 
You can zoom in and out and pan around as well.  You are looking for anything that does not look 
correct, to allow you to go back and correct it to get a good surface.  Experiment with the options 
– HAVE FUN! 
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Close the window when you are done viewing the drawing in 3D. 

 

Step 7) Cleanup of screen 
 
We will erase the TIN from the screen so we can see the rest of the job.  We will use a shortcut to 
do this.  Press an E (for erase) followed by <enter>, then when prompted to select objects, 
answer L <enter> to select the last object drawn, then press <enter> again.  MicroSurvey has 
shortcuts called selection sets like Last and Previous that can speed your work. 
 
(If the Tin does not erase then try again and pick one of the triangles while in the erase 
command) 
 
Occasionally you may need to redraw the display in MicroSurvey to clean up artifacts from 
erasing entities.  
 
Pick the redraw button on the left side menu to run the redraw command. 
 

 
 

 

Step 8) Quick Contours 
 
Contours may be generated by three different methods.  To set the correct method for what you 
require we need to do 2 things.  First we need to set the color map to what we require.  Go to the 
MsModeling pulldown menu | Color Options | Reset Color Map. 
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Before Reset 

 
After Reset 

 
Pick on the RESET button and then the OK button. 
 
What this is doing is setting the colors to standard CAD colors so you can set your pen widths for 
plotting easily. 
 
Now we need to tell the routine which method to use to color the contours and to set the interval. 
 
Go to the MsModeling pulldown menu | Color Options | Contour Color Settings 
 

 
 
 
Set your defaults to 
match this dialog 

 
We will draw our contours on their own layer. Make a new layer named contours and make it 
current, just like you did for the lines layer previously.  Pick the Layer Management button.  Pick 
the new button at the top left end of the Explorer toolbar. Type in CONTOURS in the edit box and 
press Enter.  Double click on the CONTOURS layer to place the blue check button, to make it 
current.  
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Close the Explorer. 
 
Select the Contour command from the MsModeling pulldown menu, press <enter> to accept 
the <GROUND> surface (the surface to which you extracted your points) and press <enter> to 
temporarily “show the contours". 
 

 
 
The contours are NOT yet part of the drawing.  They are only in memory and displayed 
temporarily on screen. 
 
The contours are displayed temporarily until the next refresh of the screen, such as pan or zoom 
or redraw.  If there was a problem with a bad elevation, you could fix it before drawing permanent 
contour lines. 
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Step 9) Setting up a Boundary 
 
Most of the time in a topo survey you will take shots outside of the actual property lines for 
control, but you may only want to display contours within the property outline.  We will do this by 
setting up and using a boundary.  A boundary acts like a Trim line, cropping the contours so they 
do not pass over the polyline.  We will add a boundary polyline, then draw and label contours for 
this site.  
 
Refresh the screen by picking on the redraw button on the left side menu. 
 

 
 
The contours disappear because they were displayed temporarily with the show command.   You 
can also use the mouse wheel to zoom out a bit, if you wish. 
 
Draw a polyline similar in shape to the bold line shown below to use as a boundary.  This line 
might represent a property line or an arbitrary trim line for the contours.  (Your polyline will not be 
bold by default.  We made this one bold so you could see it easily.) 
 

 
 
If you are unfamiliar with the polyline command, type PL then left click on each location where 
you would like a vertex, then finish by typing a C to close the polyline into a closed polygon 
suitable for a boundary.  (See the MicroSurvey help for more information). 
 
Select this polyline as a boundary, by running the Boundary Options | Set Boundary command 
from the MsModeling pulldown menu and selecting the polyline boundary you just created.  
Press <enter> to complete the selection.   
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Now the contours will be limited to within this boundary, when we run the contour command again 
to draw them. (See the help file for more on boundaries, including nested boundaries) 
 
Now we will draw the contours permanently, honoring our new boundary. 
   
 

Step 10) Final Contours 
 
Select Contour from the MsModeling pulldown menu, press <enter> to accept the 
<GROUND> surface (the surface to which you extracted your points) and type D at the command 
line, and NO to the Close All prompt.  
 
You will now see the following on screen. 
 

 
 
The drawing is getting cluttered, so let’s turn off all layers except the Contours layer.  Go to the 
MsTools  | Layer Control | Isolate.  Then pick on one of the contours and press <enter>.   
 
What you are left with is this: 
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Erase the polyline we drew for the boundary, as it is no longer needed, because the contours are 
now drawn and trimmed. 
 
Type E enter and pick the boundary polyline, then press enter. 
    

Step 11) Labeling Contours 
 
Zoom in on the steep slope in the NW part of the site.  To zoom window, press Z <enter> W 

<enter> and specify two corners. (Or, you can use the  button on the left side of the screen 
to zoom window.) 
 
The black box in the image below shows you where to pick for the Zoom Window command. 
 
 

 
 
Select Annotate | Label Contours from the MsModeling pulldown menu.  You will be prompted 
for a text height.  You may specify one graphically by clicking on the screen to indicate the text 
height, or enter a number.  In this case a height of 2.5 was used. 
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Next you will be repeatedly prompted for label locations.   
Select label location (Undo/Control): 
 
Click on contours where you would like labels, and the labels will be placed and the contours 
trimmed as needed. 
 

 
 
NOTE: To label many contours in a straight row, draw a 3Dpolyline across the contours where 
you wish to have them labeled.   

 
Then run the Label Contours command again – this time after giving the text height, pick the 
CONTROL option by typing C and Enter.   
 
Then by following the prompts, select all the contours to label (be sure to not pick the polyline to 
be used as control lines to label along).  After picking all the contours to be labeled – press enter.  
Then pick the control polyline and you should see the labels start to draw on the contour lines 
exactly where the control polyline intersected them.  The Control polyline is automatically 
removed from the drawing. 
 

 
 
Now lets Zoom to the Extents of the drawing to see everything on screen.   
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Type Z <enter> then E <enter>, or pick the .button. 
 
Now we are going to Smooth the contours.  Go to the MsModeling pulldown menu | Annotate | 
Smooth Contours. 
 
Either pick the contours to smooth or simply press <enter> to select them all automatically. 
 
After smoothing your diagram should look like this. 
 

 
 
 
 

Step 12) Saving Your Work 
 
Now save your job by picking the save command on the file menu.  You also need to save the 
surface by going to the MsModeling pulldown menu | Surface Operations.   
 



 

54  Getting Started in MicroSurvey CAD 2010 

 
 
Pick the surface name on the left side of the dialog and then select the Write QSB button. 
 
Set the folder to the same location we started the job.  Do not place the file in the SOKKIA.MSJ 
folder.  Enter the name SOKKIA and press the SAVE button. 
 
This keep the MSZ file quite small as well as making the QSB file available in other jobs, if 
desired. 
 

 
 
Pick the OK button on the previous dialog to continue 
 
Go to the File menu and pick on the command SAVE to ensure that the DWG and MSZ files are 
also saved. 
 
Your drawing and the database are now saved along with the surface file. 
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You may now exit the program via the File pulldown menu. 
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Simple Traverse Tutorial 
 
 
Because of the size and complexity of this tutorial we have broken it down into 9 smaller steps to 
make it easier for you to follow. 
 
Step 1) Starting the Job 
 
Step 2) Setting the Defaults 
 
Step 3) Manual Traverse Entry 
 
Step 4) Start Entering Shots 
 
Step 5) List of Data to Enter 
 
Step 6) Coordinating the Traverse 
 
Step 7) Computing Closure 
 
Step 8) Adjust Angles + Compass Balance 
 
Step 9) Listing the Traverse 
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Step 1) Starting the Job 
 
In this cookbook-style tutorial we will enter a simple 2D traverse around a farm. This traverse was 
done to locate the corners of the boundary, and to locate a building on the farm.  
 
Here is what your finished product will look like. 
 
 

 
 
Overview: 
The surveyor began by setting up on one corner of the farm property and assigning a coordinate 
of North = 1000, East = 1000, Elev = 0, Point number = 1. He then backsighted an iron bar with a 
known direction of 214 degrees 12 minutes, 15 seconds. Since he could not directly set up on all 
the bars on the property because of rocks, hedges, and fences, he traversed around the property 
taking side shots into the corners. On the traverse, he also located three corners of a shed. 
 
To Begin: 
To begin, start a new drawing by running the MicroSurvey Project Manager command, found 
under the File drop-down menu. 
 
Pick the New button on the Project Manager, and fill in the name of the job and call it FARM-a. 
Then pick Save to continue. 
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Next you will see the General Configuration Options dialog box. 
Set the scale and other settings as shown below. 

Step 2) Setting the Defaults 
 
 
Once the new job opens you will be asked 
to fill out the following as shown, setting the 
units to Feet, Azimuths and the scale to 
1=500’.  Do not pick the OK button yet! 
 
 
 

 
 
Main Job Defaults dialog box 
 
From the bottom of this dialog box, select the Toggles button. Set the System Toggles as shown 
in the 4 Figures below. 
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Now press the OK button to return to the previous dialog – and press the OK button again to 
continue. 
   
 

 

Step 3) Manual Traverse Entry 
 
This is what your screen should now look like: (if the Assistant is not on screen then go to the 
MsTools menu | MicroSurvey Assistant, or type Assistant at the command line and press Enter. 
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Next, from the Assistant, pick the Traverse Entry / Edit / Adjustment button: 
 

 
 
Pick the Enter Traverse Field Notes button.  
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Pick on the New File button 
 
MicroSurvey will respond with a dialog box for you to enter your job name. Enter FARM-a in the 
dialog box as shown below (it may already default to this name): 
 

 
 
Pick the SAVE button to continue.  You will be prompted with a dialog box to fill out with 
information about the traverse: 
 

 
 
Pick OK and then you will be asked: 
 

 
 
Answer NO, as we will use the normal dialog boxes to enter the traverse.   
 
Answer Yes to the following dialog, so we start entering data with dialog boxes: 
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Now you are asked to enter the information for your first setup station, with appropriate backsight 
information. 
 

 
 
We have a Setup Point of 1 with coordinates of N=1000, E=1000, Z=0 so enter the Setup Point 
Number as 1 and then pick the EDIT button to the right of the point number.  Fill in the new 
Dialog as shown below and pick OK to finish.  
NOTE: Use the TAB key to move between fields: 
 

 
 
We have a backsight azimuth of 214 degrees 12 minutes 50 seconds from where we set up, so a 
backsight azimuth of 214.1250 in the edit box, as shown below: (Leave the other entries as 
shown) 
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Now pick the OK button to continue. 
 
The program will go immediately into the data entry mode.  
   

Step 4) Start Entering Shots 
 
Enter the first shot information into the dialog box as shown below. 
 

 
 
(If the above dialog asks for Vertical Angles and Slope Distances instead of the Horizontal 
Distance and Vertical Distance, then you did not set the system toggles correctly.  Exit out of the 
Traverse Entry Mode, change the Toggles to match what was given earlier and start the traverse 
entry over again) 
Pick the OK button or press <enter> to continue 
 
The program will compute the coordinate and display the information in a dialog box: 
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Pick OK to accept this information.  
 
MicroSurvey allows you to switch back and forth between entering traverse legs and entering side 
shots at any time. We will enter the traverse and side shots together. 
 
Rather than fill up this entire manual with screen shots showing the information to type into this 
tutorial, we are going to list the shots and setup information to enter.  (To start a new setup, just 
pick Next Setup or press Esc at the Enter Correct Data For Shot dialog box.  The program will 
return to the setup dialog box.) 
 
At this point you will be asked for the next side shot to be entered from the same setup.  We have 
no more shots from this setup so we need to traverse forward to the last shot we just finished 
entering. 
 
 
 
Pick the Next Setup button or press the 
Esc key on your keyboard to return to 
the Enter the Setup Information dialog 
box. 
 

 
 
 
Step 5) List of Data to Enter 

 
You will notice it has automatically updated the setup point number and the backsight point 
number with the following data: 
 
Set up on Point 7 and backsight 1. 
Pick the OK button to accept these values. 
 
Now you can enter the next Shot 
 
Horizontal Angle :131.0316 
Horizontal Distance :248.31 
Vertical Distance :0 
Point Number :8 
Description : 
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Pick the OK button to continue.  Press the OK button to accept the calculated coordinate. 
Next pick the Next Setup button to go back to the setup dialog box. 
 
Set up on Point 8 and backsight 7. 
Pick the OK button to accept these values. 
 
Enter the following Shot: 
 
Horizontal Angle :134.2554 
Horizontal Distance :83.92 
Vertical Distance :0 
Point Number :2 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated coordinate. 
Do NOT Pick the Next Setup button. 
 
Enter the following Shot: 
 
Horizontal Angle :231.5652 
Horizontal Distance :302.5 
Vertical Distance : 0 
Point Number :9 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated coordinate. 
Next pick the Next Setup button to go back to the setup dialog box. 
 
Setup on Point 9 and backsight 8. 
Pick the OK button to accept these values. 
 
Enter the following Shot: 
 
Horizontal Angle :237.1721 
Horizontal Distance :341.71 
Vertical Distance : 0 
Point Number :10 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated coordinate. 
Next pick the Next Setup button to go back to the setup dialog box. 
 
Setup on Point 10 and backsight 9. 
Pick the OK button to accept these values. 
 
Enter the following Shot: 
 
Horizontal Angle :203.2344 
Horizontal Distance :60.18 
Vertical Distance : 0 
Point Number :3 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated coordinate. 
Do NOT Pick the Next Setup button. 
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Enter the following Shot: 
 
Horizontal Angle :86.3210 
Horizontal Distance :312.35 
Vertical Distance : 0 
Point Number :15 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated coordinate. 
Next pick the Next Setup button to go back to the setup dialog box. 
 
Setup on Point 15 and backsight 10. 
Pick the OK button to accept these values. 
 
Enter the following shot: 
 
Horizontal Angle :123.1746 
Horizontal Distance :40.19 
Vertical Distance : 0 
Point Number : 4 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated coordinate. 
Do NOT Pick the Next Setup button. 
 
Enter the following Shot: 
 
Horizontal Angle :317.1045 
Horizontal Distance :56.92 
Vertical Distance : 0 
Point Number :12 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated coordinate. 
Do NOT Pick the Next Setup button. 
 
Enter the following Shot: 
 
Horizontal Angle :300.1321 
Horizontal Distance :38.54 
Vertical Distance : 0 
Point Number :13 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated coordinate. 
Do NOT Pick the Next Setup button. 
 
Enter the following Shot: 
 
Horizontal Angle :287.3017 
Horizontal Distance :51.68 
Vertical Distance : 0 
Point Number :14 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated coordinate. 
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Do NOT Pick the Next Setup button. 
 
Enter the following Shot: 
 
Horizontal Angle :258.1506 
Horizontal Distance :658.78 
Vertical Distance : 0 
Point Number :16 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated coordinate. 
 
Next pick the Next Setup button to go back to the setup dialog box. 
 
Set up on Point 16 and backsight 15. 
Pick the OK button to accept these values. 
 
Enter the following Shot: 
 
Horizontal Angle :131.4731 
Horizontal Distance :69.42 
Vertical Distance : 0 
Point Number :5 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated coordinate. 
Do NOT Pick the Next Setup button. 
 
Enter the following Shot: 
 
Horizontal Angle :264.1350 
Horizontal Distance :695.37 
Vertical Distance : 0 
Point Number : 6 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated coordinate. 
 
Next pick the Next Setup button to go back to the setup dialog box. 
 
Setup on Point 6 and backsight 16, and   
Pick the OK button to accept these values. 
 
Enter the following Shot that is back to the original setup point: 
 
Horizontal Angle :273.5655 
Horizontal Distance :1399.37 
Vertical Distance : 0 
Point Number :21 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated coordinate. 
 
Next pick the Next Setup button to go back to the setup dialog box. 
 
Setup on Point 21 and backsight 6. 
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Pick the OK button to accept these values. 
 
Now take the final shot to the closing foresight point. This is the starting backsight point. 
 
Horizontal Angle :139.3500 
Horizontal Distance :100 
Vertical Distance : 0 
Point Number :31 
Description : 
 
Pick the OK button to continue.  Press the OK button to accept the calculated coordinate. 
 
Next pick the Next Setup button to go back to the setup dialog box. 
 
This concludes the survey data entry. You can exit by picking the CANCEL button. 
   

Step 6) Coordinating the Traverse 
 
You should be back to the assistant menu shown below: 
 

 
 
We are going to Edit your Traverse Data to ensure you have not made any mistakes in entry 
 
Pick on the Edit Traverse Data button. 
 
You will see the following Summary: 
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Close the Assistant dialog that appeared on top of the window. 
Scroll down using the bar on the right to see the rest of the listing as shown below: 
 

 
 
(If you do have errors then you can edit the entry and make the correction now.) 
 
Select Re-coordinate Traverse from the Edit Menu on the Active Drawing Editor.  Or you 
can type Ctrl-R if the editor window is current. 
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You will be given the option of creating a 
Re-coordination Report or Log.  Accept the 
defaults as shown and pick OK. 
 

 
 
 
After the traverse has been coordinated you will be returned to the Assistant.  Pick the EXIT 
button to leave the Assistant. 
 
You can also close the Active Traverse Dialog, at his point. 
 
Next go to the MsTools | Print / Edit / View Reports | View Log File command: 
 
You will see the following Window appear.  You can scroll up and down in it to see the entire 
report. 

       
 
You may print this report now by going to the File pulldown menu on this window, and pick the 
Print command. 
 
Pick the X in the top right of the window to close it. 

Pick the Zoom Extents Button on the right of the screen,  
 
Now your screen should look like this: 
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Save the project by entering the SAVE command.    

Step 7) Computing Closure 
 
Now we will compute the closure error.  Select the ASSISTANT from the MS Main Control toolbar 

 (or MicroSurvey Assistant from the MsTools menu), then pick the Traverse Entry /Edit/ 
Adjustment button.  Then pick the Compute Traverse Closure button.  You will be asked: 
 

 
 
Pick the YES button to continue. 
 
Now you will be asked if you have a Closed Loop or Open traverse. 
 

 
 
Select Open Traverse, because we have an external backsight and closing foresight on this 
traverse. 
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MicroSurvey quickly analyzes the traverse and finds the last instrument setup point number. It 
offers this as the closing point number:  Our traverse matches the first of the 3 scenarios 
presented: 
 

 
 
Pick the OK button to continue. 
 
You will be shown the calculated coordinates of point 21: 
 

 
 
You must change these to reflect the true coordinates of point 21.   
To make this easy for you pick on the button marked Copy. 
 
This brings up another dialog that allows you to enter in the point number that has the correct 
coordinates for point 21. 
 

 
 
21 is the same point as 1 so enter point number 1 and Pick OK to return to the previous dialog. 
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It will now look like this: 
 

 
 
 
Pick the OK button to continue. 
 
Enter Closing Foresight Point 31, as shown below: 
 

 
 
Pick the OK button to continue. 
 
You are asked for the actual coordinates of point 31.  The numbers shown are the calculated 
values.  Enter in the following KNOWN values, as shown: 
 

Pick the OK button to continue and the 
Traverse Closure Report will be generated on 
the Command Window.  
 
Then pick the EXIT button on the Assistant. 
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Open the View Log (you can 
also open this with a button on 
the Ms Main Control Toolbar) 
and then scroll down using the 
slide bar on the right, until you 
see the following.  (Remember 
you can print this by going to 
the File pulldown menu on the 
Log Window and run the Print 
command.) 
 

 
Pick the X in the top right corner of the window to close it. 
    

Step 8) Adjust Angles + Compass Balance 
 
We are now going to do an Angular Balance on this traverse.  First, turn the Point Protection 
toggle off using the Hot Toggles. 
 
Then go to the MsTraverse drop-down menu | Traverse Calculations and pick on the Angle 
Balance option. 
 
The angles on this traverse will be balanced. The closure will be recomputed and displayed. Pick 
on the ViewLOG button again and scroll down to the bottom to see the results shown here. 
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Pick the X in the top right corner of the window to close it. 
 
Next you can perform a compass balance by going to the MsTraverse drop-down menu | 
Traverse Calculations and pick on the Compass Method Adjustment option. 
 
The traverse will be balanced according to the Compass Rule. The coordinates for the main 
traverse and any side shots will be adjusted. 
 
Now Pick on the ViewLOG button again and scroll down to the bottom to see the results shown 
here. 
 

 
 
Pick the X in the top right corner of the window to close it. 
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Now lets see the traverse on the screen. to the MsTraverse drop-down menu | Traverse 
Entry/Editing and pick on the Show Traverse Graphically option. 
 

 
 
Answer NO if you wish to see the linework temporarily until a redraw command cleans up the 
screen.  Answer YES if you wish to draw every line into the drawing permanently (with the toggles 
and labeling defaults controlling their appearance).   
Enter YES to bring up this dialog: 

 
Enter YES to draw all lines. 
 

 
With your Hot Toggles set as shown below, you will be asked: 
  
Pick the side you want the bearing placed/Above/Below: <enter> 
 
Press Enter on each prompt and you will get a drawing like this: 
 

     
 
You can isolate the line work layer only, by going to the MsTools menu | Layer Control | Isolate, 
and then pick on one of the lines only.  This will leave you will a cleaner looking drawing, with the 
rest of the information on the other layers being frozen for you. 
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Now your drawing will look like this: 

 
 

Step 9) Listing the Traverse 
 
Finally, we will dump a listing of the traverse to the Log file.  Go to the MsTraverse menu | 
Traverse Entry/Editing and pick on the List Traverse File option. 
There are two formats of the listing: long and short. 
 

 
 
Pick YES for the Short Listing. 
 
Now Pick on the ViewLOG button again and scroll down to the bottom to see the results shown 
here. 
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Keep scrolling to see the entire listing. 
 
(Remember you can print this by going to the File pulldown menu and picking on the Print 
command.) Pick the X in the top right corner of the window to close it. 
 
The new Active Drawing Technology Editor offers formatted listings of much higher quality than 
ever available before.  To start the ADT editor, run the Active Traverse Editor command found 
in the MsTraverse menu.  
 
The following is a print preview from the File menu of the Editor: 
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Exit the dialog. 

Go to the File menu and pick on the command SAVE to ensure that the DWG and MSZ files 
are saved, and then you can exit the program. 

 (End of tutorial) 
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Property Line Tutorial 
 

Because of the size and complexity of this tutorial we have broken it down into 15 smaller steps 
to make it easier for you to follow. 
 
Step 1) Starting the Job 
 
Step 2) COGO Calcs (Property Boundaries) 
 
Step 3) Distance/Distance Intersection 
 
Step 4) 3 Point Curve 
 
Step 5) More COGO 
 
Step 6) Bearing/Distance Intersection 
 
Step 7) And More COGO 
 
Step 8) COGO One More Time 
 
Step 9) More 3 Point Curves 
 
Step 10) Setting the Toggles 
 
Step 11) Locating the Buildings (Using OFFSETS) 
 
Step 12) Work on the SHED 
 
Step 13) Line Inverse 
 
Step 14) Job Complete 
 
Step 15) Batch COGO Completed 
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Step 1) Starting the Job 
 
In this tutorial, we will be using COGO Only, to calculate a drawing of three adjacent properties 
with a house and shed on the center property. During this tutorial, we will record our entry into the 
new Active Batch Cogo System.   
 
The figure below illustrates some of the field notes taken by a survey party to give you a feeling 
for what you are entering.  You do not need to keep this diagram open as the following steps will 
walk you through entry of the data. 
 

 
Property field notes 

 
To begin, start a new drawing by running the MicroSurvey Project Manager command, found 
under the File drop-down menu. 
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Pick the New button in the MicroSurvey 
Project Manager, and name the project 
COGO. Then pick Save to continue. 

 

 

   
 

 

 
 
Set the 
MicroSurvey 
General 
Configuration 
Options to 
Metric, 
Bearings 
with a scale 
factor of 
1:250. This 
scale is 
chosen so 
the bearings 
and 
distances will 
be clear in 
MicroSurvey. 

 
Using the same procedure as the Traverse tutorial, set up the MicroSurvey system toggles as 
shown. 
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If the Assistant appears on screen, pick the EXIT button to remove it. 

 

Step 2) COGO Calcs (Property Boundaries) 
 
Before we start performing COGO calculations, turn on the Batch COGO recording control by 
typing: MS_BATCH or select it from the MsCogo | Active Batch COGO | Load Control Dialog.  
The following dialog should appear 
 

 
 
Pick the Set button and choose New: 
 

 
 
You will be prompted to enter a batch file name. Enter "Property Line Tutorial" and press 
Save. 
 

 
 
 

 
Now, Pick the Start button, and the dialog should show Recording ON. 
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To begin calculating the property boundaries, Type COGO at the MicroSurvey command prompt. 
Respond as shown to these prompts: 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
(RECORDING) Enter From Point: <1>(Backup/Toggles/Curve/CB/CS/CF): 1 <enter> 
That coordinate is not in the file. Please enter it now. 
 
Fill out the dialog as shown (be sure to use the mouse or the TAB key to move between fields in 
the dialog) 
 

 
 
Pick the OK button to continue. 
 
Because point #1 did not exist, MicroSurvey automatically asked you to define its location.  Then 
it assumed you were starting from point 1 and asked you for the bearing next. 
 
Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): 155.3030 <enter> 
-->Bearing used = N55°30'30"E 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): 30 <enter> 
-->Distance used = 30.000000 
Pick or Enter the Solve Point: <2>(Backup Toggles): 2 <enter> 
Enter Description:<>: BAR <enter> 
1  N55°30'30"E  dist=    30.000   N=    1016.989   E=    2024.726  2 
Bearing input=155.3030       Distance Input=30 
Pick the side you want the bearing placed/Above/Below:A <enter> 
 
The bearing you just entered can be read as: First Quadrant (1), Fifty-five degrees, Thirty 
minutes, Thirty seconds, or N 55° 30’30" E. 

At this point pick the Zoom Extents button  on the left side menu so we can see the 
info already entered on screen 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
(RECORDING) Enter From Point: <2>(Backup/Toggles/Curve/CB/CS/CF): <enter> 
Options: +/- or Pt..Pt+-Angle 
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Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): 2..1-120 <enter> 
-->Bearing used = S64°29'30"E 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): 32 <enter> 
-->Distance used = 32.000000 
Pick or Enter the Solve Point: <3>(Backup Toggles): <enter> 
Enter Description:<>: POST <enter> 
2  S64°29'30"E  dist=    32.000   N=    1003.208   E=    2053.607  3 
Bearing input=2..1-120       Distance Input=32 
Pick the side you want the bearing placed/Above/Below:A <enter>  
 
By replying to ENTER BEARING with "2..1-120", you told MicroSurvey to take the bearing from 
point 2 to point 1 and turn a counterclockwise angle of 120 degrees. Now let's continue… 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
(RECORDING) Enter From Point: <3>(Backup/Toggles/Curve/CB/CS/CF): <enter> 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): 2..3+90 <enter> 
-->Bearing used = S25°30'30"W 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): 40 <enter> 
-->Distance used = 40.000000 
Pick or Enter the Solve Point: <4>(Backup Toggles): <enter> 
Enter Description:<POST>: <enter> 
3  S25°30'30"W  dist=    40.000   N=     967.107   E=    2036.381  4 
Bearing input=2..3+90       Distance Input=40 
Pick the side you want the bearing placed/Above/Below: <enter> 
 

Pick the Zoom Extents button from the View toolbar:  
  
 
At this point the screen should look something like this: 
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Rather than continuing from point 4, we are going to jump back to point 1 and started a new 
calculation: 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
(RECORDING) Enter From Point: <4>(Backup/Toggles/Curve/CB/CS/CF): 1 <enter> 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): 1..2+92 <enter> 
-->Bearing used = S32°29'30"E 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): 37.5 <enter> 
-->Distance used = 37.500000 
Pick or Enter the Solve Point: <5>(Backup Toggles): 5 <enter> 
Enter Description:<BAR>: <enter> 
1  S32°29'30"E  dist=    37.500   N=     968.370   E=    2020.144  5 
Bearing input=1..2+92       Distance Input=37.5 
Pick the side you want the bearing placed/Above/Below: <enter> 
   

Step 3) Distance/Distance Intersection 
 
Next is a DISTANCE - DISTANCE calculation so we can establish the center point of the curve at 
the front of the property. 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt  
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
(RECORDING) Enter From Point: <5>(Backup/Toggles/Curve/CB/CS/CF): 4 <enter> 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): <enter> 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): 22 <enter> 
-->Distance used = 22.000000 
Pick or Enter the Solve Point: <6>(Backup Toggles): R1 <enter> 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter Distance2: <>:(Backup Toggles Points Line): 22 <enter> 
-->Distance used = 22.000000 
Pick or Enter the To Point: <5>:(Backup Toggles): 5 <enter> 
Point :119126896 North :   947.363 East  :  2026.678 
Do you want to use this solution (Y/N) (N for other solution) y <enter> 
4  S26°10'16"W  dist=    22.000   N=     947.363   E=    2026.678  R1 
Enter Description:<BAR>: C <enter> 
Pick the side you want the bearing placed/Above/Below: <enter> 
6  N17°16'38"W  dist=    22.000   N=     968.370   E=    2020.144  5 
Pick the side you want the bearing placed/Above/Below: <enter> 
Point :119126896 North :   947.363 East  :  2026.678 
Distance1 input=22  Distance2 input=22 
 

Pick the zoom extent button  to see the entire drawing. 
 
Note that no special commands were required to do the DISTANCE - DISTANCE calculation; 
MicroSurvey knew to do this when you replied to a bearing prompt with the <enter> key. This 
logic is followed for all intersection calculations. Since this calculation yields two possible 
solutions, you were offered the opportunity to use the "other" solution. Generally MicroSurvey 
works in a clockwise manner, so the first solution offered is usually the clockwise solution. 
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Step 4) 3 Point Curve 
Now we do a 3 point inverse to draw the curve and get the curve information:  
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
Enter From Point: <R1>(Backup/Toggles/Curve/CB): 5..R1..4 <enter> 
Arc:         16.683  Chord:         16.286  Tangent:          8.766  Delta: 43.2655  Radius:         22.000 

 
 
 
By entering three numbers as shown above, you told MicroSurvey to compute an angle clockwise 
from point 5 to point 4 with point R1 as the center of curvature. 
 

You should see this now: 

 
 
 
    

Step 5) More COGO 
 
Enter From Point: <R1>(Backup/Toggles/Curve/CB): 1 <enter> 
Options: +/- or Pt..Pt+-Angle 
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Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): 2..1 <enter> 
-->Bearing used = S55°30'30"W 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): 2..1 <enter> 
-->Distance used = 30.000000 
Pick or Enter the Solve Point: <6>(Backup Toggles): 13 <enter> 
Enter Description:<C>: POST <enter>   
1  S55°30'30"W  dist=    30.000   N=     983.011   E=    1975.274  13 
Bearing input=2..1       Distance Input=2..1 
Pick the side you want the bearing placed/Above/Below:a <enter> 
 
Entering the distance as "2..1" tells MicroSurvey to use the distance from point 2 to point 1, or 30 
meters in this case. 

 

Step 6) Bearing/Distance Intersection 
 

Next we want to do a BEARING - DISTANCE calculation from point 13 and point R1. Again, we 
will get two possible solutions and this time the "other" solution will be the one we want. 
 
 
 
Pick the zoom extent button 

 to see the entire drawing. 
 
 
 
At this point your drawing 
should look like this: 
 

 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
Enter From Point: <13>(Backup/Toggles/Curve/CB): <enter> 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): 13..1+70 <enter> 
-->Bearing used = S54°29'30"E 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): <enter> 
Pick or Enter the Solve Point: <14>(Backup Toggles): <enter> 
Options: Pt..Pt+-Angle 
Enter Quadrant Bearing #2 like QDD.MMSS: <>:(Backup Toggles Points Line): <enter> 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter Distance2: <>:(Backup Toggles Points Line): 22 <enter> 
-->Distance used = 22.000000 
Pick or Enter the To Point: <14>:(Backup Toggles): R1 <enter> 
Point :119126896 North :   933.912 East  :  2044.087 
Do you want to use this solution (Y/N) (N for other solution) n <enter> 
Point :119126896 North :   959.450 East  :  2010.296 
Do you want to use this solution (Y/N) (N for other solution) y <enter> 
13  S54°29'30"E  dist=    40.566   N=     959.450   E=    2010.296  14 
Enter Description:<>: POST <enter> 
Pick the side you want the bearing placed/Above/Below: <enter> 
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14  S56°40'24"E  dist=    22.000   N=     947.363   E=    2026.678  R1 
Pick the side you want the bearing placed/Above/Below: <enter> 
Bearing input=13..1+70    Distance input=22 
   

Step 7) And More COGO 
 
Now we calculate point 19: 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
Enter From Point: <14>(Backup/Toggles/Curve/CB): 3 <enter> 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): 2..3 <enter> 
-->Bearing used = S64°29'30"E 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): 2.35 <enter> 
-->Distance used = 2.350000 
Pick or Enter the Solve Point: <6>(Backup Toggles): 19 <enter> 
Enter Description:<POST>:  POST <enter> 
3  S64°29'30"E  dist=     2.350   N=    1002.196   E=    2055.728  19 
Bearing input=2..3       Distance Input=2.35 
Pick the side you want the bearing placed/Above/Below: <enter> 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
Enter From Point: <19>(Backup/Toggles/Curve/CB): <enter> 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): 229.2930 <enter> 
-->Bearing used = S29°29'30"E 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): 1..2 <enter> 
-->Distance used = 30.000000 
Pick or Enter the Solve Point: <6>(Backup Toggles): 20 <enter> 
Enter Description:<BAR>:  <enter> 
19  S29°29'30"E  dist=    30.000   N=     976.083   E=    2070.497  20 
Bearing input=229.2930       Distance Input=1..2 
Pick the side you want the bearing placed/Above/Below: <enter> 
 
Here is what should be on your screen, so far! 

 



 

90  Getting Started in MicroSurvey CAD 2010 

Step 8) COGO One More Time 
 
Now we will calculate Point 21 using a Distance-Distance Intersection. Take the second distance 
from the points on the drawing by entering a two point inverse: 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
Enter From Point: <20>(Backup/Toggles/Curve/CB): <enter> 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): <enter> 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): 33.2 <enter> 
-->Distance used = 33.200000 
Pick or Enter the Solve Point: <21>(Backup Toggles): <enter> 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter Distance2: <>:(Backup Toggles Points Line): 4..R1 <enter> 
-->Distance used = 22.000000 
Pick or Enter the To Point: <21>:(Backup Toggles): R1 <enter> 
Point :119126896 North :   951.388 East  :  2048.307 
Do you want to use this solution (Y/N) (N for other solution) Y <enter> 
20  S41°56'32"W  dist=    33.200   N=     951.388   E=    2048.307  21 
Enter Description:<>: BAR <enter> 
Pick the side you want the bearing placed/Above/Below: <enter> 
21  S79°27'21"W  dist=    22.000   N=     947.363   E=    2026.678  R1 
Pick the side you want the bearing placed/Above/Below: <enter> 
Point :119126896 North :   951.388 East  :  2048.307 
Distance1 input=33.2  Distance2 input=4..R1 
  
Here is what should be on your screen, so far! 
 

 

Step 9) More 3 Point Curves 
 
Next we do a 3 point inverse to draw the curve between points 4 and 21 and get the curve 
information:  
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
Enter From Point: <21>(Backup/Toggles/Curve/CB): 4..R1..21 <enter> 
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Arc:         20.460  Chord:         19.730  Tangent:         11.037  Delta: 53.1705  Radius:         22.000 

 
 
And the last curve can be calculated between points 14 and 5. 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
Enter From Point: <21>(Backup/Toggles/Curve/CB): 14..R1..5 <enter> 
Arc:         15.127  Chord:         14.831  Tangent:          7.876  Delta: 39.2345  Radius:         22.000 

 
 

Step 10) Setting the Toggles 
 
 
At this point your 
job should look like 
this: 
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Now we will use the Hot Toggles dialog to change the toggles so that MicroSurvey will not draw 
bearings and distances on the sides of the house and shed. 
 
Click the Draw Bearings toggle. 
Click the Draw Distances toggle. 
 

The Hot Toggles 
dialog should 
now look like 
this: 

 

Step 11) Locating the Buildings (Using OFFSETS) 
 
Now we will locate the house and shed on the center property. The figure below shows these 
structures in expanded detail as defined by the field notes. 
 

 
 
We begin locating the structures with a BEARING - BEARING intersection with OFFSETS. The 
bearings are taken from the lines by doing two point inverses. The offset distances are entered by 
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using a % sign. Long ago one of our customers said they always write their field notes with o/s to 
signify offsets so they recommend we use the % sign. It works… 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
Enter From Point: <21>(Backup/Toggles/Curve/CB): 5 <enter> 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): 5..1%8.5 <enter> 
-->offset1 used = 8.500000  
-->Bearing used = N32°29'30"W 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): <enter> 
Pick or Enter the Solve Point: <6>(Backup Toggles): 7 <enter> 
Options: Pt..Pt+-Angle 
Enter Quadrant Bearing #2 like QDD.MMSS: <>:(Backup Toggles Points Line): 5..4%-16.49 
<enter> 
-->offset2 used = -16.490000 
-->Bearing used = S85°33'11"E 
Pick or Enter the To Point: <6>:(Backup Toggles): 5 <enter> 
Enter Description:<>:  <space><enter> 
5  N01°39'31"W  dist=    16.584   N=     984.947   E=    2019.664  7 
7  S01°39'31"E  dist=    16.584   N=     968.370   E=    2020.144  5 
Bearing1 input=5..1%8.5   Bearing2 input=5..4%-16.49 
 
To review: the % sign used in the bearings tells MicroSurvey that you are entering information on 
an offset. Positive is to the right and negative is to the left of the reference line.  
 
Next is a BEARING - DISTANCE intersection with an OFFSET. 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
Enter From Point: <7>(Backup/Toggles/Curve/CB): 5 <enter> 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): 5..1%9.1 <enter> 
-->offset1 used = 9.100000 
-->Bearing used = N32°29'30"W 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): <enter> 
Pick or Enter the Solve Point: <6>(Backup Toggles): 8 <enter> 
Options: Pt..Pt+-Angle 
Enter Quadrant Bearing #2 like QDD.MMSS: <>:(Backup Toggles Points Line): <enter> 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter Distance2: <>:(Backup Toggles Points Line): 3 <enter> 
-->Distance used = 3.000000 
Pick or Enter the To Point: <6>:(Backup Toggles): 7 <enter> 
Point :119126896 North :   987.749 East  :  2018.591 
Do you want to use this solution (Y/N) (N for other solution) y <enter> 
5  N32°29'30"W  dist=    19.441   N=     987.749   E=    2018.591  8 
Enter Description:<>:  <enter> 
8  S20°57'17"E  dist=     3.000   N=     984.947   E=    2019.664  7 
Bearing input=5..1%9.1    Distance input=3 
 
Now lets finish the house entry.  
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
Enter From Point: <8>(Backup/Toggles/Curve/CB): <enter> 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): 8..7-90 <enter> 
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-->Bearing used = N69°02'43"E 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): 2 <enter> 
-->Distance used = 2.000000 
Pick or Enter the Solve Point: <9>(Backup Toggles): <enter> 
Enter Description:<>: <enter> 
8  N69°02'43"E  dist=     2.000   N=     988.464   E=    2020.459  9 
Bearing input=8..7-90       Distance Input=2 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
Enter From Point: <9>(Backup/Toggles/Curve/CB): <enter> 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): 9..8+90 <enter> 
-->Bearing used = N20°57'17"W 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): 5 <enter> 
-->Distance used = 5.000000 
Pick or Enter the Solve Point: <10>(Backup Toggles): <enter> 
Enter Description:<>: <enter> 
9  N20°57'17"W  dist=     5.000   N=     993.133   E=    2018.671  10 
Bearing input=9..8+90       Distance Input=5 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
Enter From Point: <10>(Backup/Toggles/Curve/CB): <enter> 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): 10..9-90 <enter> 
-->Bearing used = N69°02'43"E 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): 8 <enter> 
-->Distance used = 8.000000 
Pick or Enter the Solve Point: <11>(Backup Toggles): <enter> 
Enter Description:<>: <enter> 
10  N69°02'43"E  dist=     8.000   N=     995.994   E=    2026.142  11 
Bearing input=10..9-90       Distance Input=8 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
Enter From Point: <11>(Backup/Toggles/Curve/CB): <enter> 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): <enter> 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): 8.1 <enter> 
-->Distance used = 8.100000 
Pick or Enter the Solve Point: <12>(Backup Toggles): <enter> 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter Distance2: <>:(Backup Toggles Points Line): 10.2 <enter> 
-->Distance used = 10.200000 
Pick or Enter the To Point: <12>:(Backup Toggles): 7 <enter> 
Point :119126896 North :   988.504 East  :  2029.224 
Do you want to use this solution (Y/N) (N for other solution) y <enter> 
11  S22°21'59"E  dist=     8.100   N=     988.504   E=    2029.224  12 
Enter Description:<>: <enter> 
12  S69°35'36"W  dist=    10.200   N=     984.947   E=    2019.664  7 
Point :119126896 North :   988.504 East  :  2029.224 
Distance1 input=8.1  Distance2 input=10.2 
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Step 12) Work on the SHED 
 
This completes the house; now we proceed to the shed. For the following DISTANCE - 
DISTANCE calculation, we will select the "other", or NEAR solution. 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
Enter From Point: <12>(Backup/Toggles/Curve/CB): 11 <enter> 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): <enter> 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): 4.5 <enter> 
-->Distance used = 4.500000 
Pick or Enter the Solve Point: <15>(Backup Toggles): <enter> 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter Distance2: <>:(Backup Toggles Points Line): 17.5 <enter> 
-->Distance used = 17.500000 
Pick or Enter the To Point: <12>:(Backup Toggles): 2 <enter> 
Point :119126896 North :   999.541 East  :  2023.372 
Do you want to use this solution (Y/N) (N for other solution) n <enter> 
Point :119126896 North :   999.881 East  :  2028.410 
Do you want to use this solution (Y/N) (N for other solution) y <enter> 
11  N30°16'10"E  dist=     4.500   N=     999.881   E=    2028.410  15 
Enter Description:<>: <enter> 
15  N12°09'07"W  dist=    17.500   N=    1016.989   E=    2024.726  2 
Point :119126896 North :   999.881 East  :  2028.410 
Distance1 input=4.5  Distance2 input=17.5 
 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
Enter From Point: <15>(Backup/Toggles/Curve/CB): 2 <enter> 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): <enter> 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): 16.8 <enter> 
-->Distance used = 16.800000 
Pick or Enter the Solve Point: <6>(Backup Toggles): 16 <enter> 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter Distance2: <>:(Backup Toggles Points Line): 2 <enter> 
-->Distance used = 2.000000 
Pick or Enter the To Point: <3>:(Backup Toggles): 15 <enter> 
Point :119126896 North :  1001.049 East  :  2030.033 
Do you want to use this solution (Y/N) (N for other solution) y <enter> 
2  S18°24'55"E  dist=    16.800   N=    1001.049   E=    2030.033  16 
Enter Description:<POST>:  <space><enter> 
16  S54°15'40"W  dist=     2.000   N=     999.881   E=    2028.410  15 
Point :119126896 North :  1001.049 East  :  2030.033 
Distance1 input=16.8  Distance2 input=2 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
Enter From Point: <16>(Backup/Toggles/Curve/CB): <enter> 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): 16..15-90 <enter> 
-->Bearing used = S35°44'20"E 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): 2.5 <enter> 
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-->Distance used = 2.500000 
Pick or Enter the Solve Point: <17>(Backup Toggles): <enter> 
Enter Description:<>: <enter> 
16  S35°44'20"E  dist=     2.500   N=     999.020   E=    2031.494  17 
Bearing input=16..15-90       Distance Input=2.5 
 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
Enter From Point: <17>(Backup/Toggles/Curve/CB): <enter> 
Options: +/- or Pt..Pt+-Angle 
Enter Quadrant Bearing like QDD.MMSS:<>: (Backup Toggles Points Line): 17..16-90 <enter> 
-->Bearing used = S54°15'40"W 
Options: C#=-*/sin/cos/tan... or Pt..Pt(+-*/) a Distance 
Enter the Distance: <>:(Backup Toggles Points Line): 15..16 <enter> 
-->Distance used = 2.000000 
Pick or Enter the Solve Point: <18>(Backup Toggles): <enter> 
Enter Description:<>: <enter> 
17  S54°15'40"W  dist=     2.000   N=     997.851   E=    2029.870  18 
Bearing input=17..16-90       Distance Input=15..16 
 
We need to erase a few extra lines that are on the drawing, but at this point your drawing should 
look like this: 
 

 
 
 
  
Step 13) Line Inverse 

 
Inverse:Pt..Pt/Curve Inverse:Pt..Pt..Pt 
Enter From Point: <18>(Backup/Toggles/Curve/CB): 15..18 <enter> 
15  S35°44'20"E  dist=     2.500   N=     997.851   E=    2029.870  18 
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You should see this 
information dialog. 
Press the Ok button: 

 
Press Esc to exit from COGO. 

 

Step 14) Job Complete 
 

 

The shed is now 
complete.  
 
Finally, by deleting 
unneeded lines, we 
get the property 
drawing shown here. 

 
 
Save your job by picking the SAVE command from the File pulldown menu. 
 

Step 15) Batch COGO Completed 
 
 
Now, Pick the Stop button on the Batch COGO Control window. It should show Recording OFF. 

 
 
Pick the Edit button and you should see something like this window.   
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Pick the SP and you can edit the starting coordinates. 
 

 
 
Pick the Edit menu and you can see all the commands available for building a batch file: 
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Scroll to the Bottom of the Grid and Pick 
the Type Cell: it will change to a pull down 
combo box with all the record types listed: 
 

 
 
(End of tutorial) 
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Earthwork Surface Volume Tutorial 
 
Because of the size and complexity of this tutorial we have broken it down into 15 smaller steps 
to make it easier for you to follow. 
 
Step 1) Starting the Job 
 
Step 2) Setting the Defaults and Toggles 
 
Step 3) Importing a Data Collector File 
 
Step 4) Creating the Traverse File 
 
Step 5) Processing and Editing the Traverse File 
 
Step 6) Coordinate the Traverse 
 
Step 7) Working with AutoMAP 
 
Step 8) Start the First Surface 
 
Step 9) Make the First TIN 
 
Step 10) Start the Second Surface 
 
Step 11) Extract the Second Surface 
 
Step 12) Make the Second TIN 
 
Step 13) Calculate Surface Volumes between the 2 Surfaces 
 
Step 14) Rendering the Top Surface 
 
Step 15) Cross Sections across the Job 
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Step 1) Starting the Job 
 
To begin, start a new drawing by running the MicroSurvey Project Manager command, found 
under the File drop-down menu. 
 

 
 
Pick the New button on the Project Manager.  Fill in the name of the job and call it VOLUMES.  
 

 
Then pick Save to continue. 

 



 

102  Getting Started in MicroSurvey CAD 2010 

Step 2) Setting the Defaults and Toggles 
 
As soon as the job is open you are asked to check or set the General Defaults. 
 

 
 
Please take the time to make your General Defaults the same as shown here.  Pick the OK 
button to continue. 
 
 
 
Now that your job is open, you 
have many options presented to 
you.  The first set of options are 
available from the MicroSurvey 
Assistant – Main Menu.   The 
MicroSurvey Assistant can be 
loaded by going to the MsTools 
menu.  This is a floating dialog 
box with commands on it that you 
can pick. 
 

 
 
We will go and check and set the program defaults.  To do this, pick the button Set Program 
Defaults.  Next you will be given another dialog box to choose from. 
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In this dialog box we can choose to set any 
of the drawing defaults that we may need.  
In this tutorial we are going to assume that 
everything we do not look at is considered 
okay for this job. 
 

 
 
We need to check our Toggles so pick the COGO Toggles button.  This will show you the 
following dialog boxes.  Please make yours look the same as ours shown here.  When done pick 
the OK button. 
 

 
 
 

 
 
Pick the OK button to continue.  This will take you back again to the MicroSurvey Assistant – 
Defaults Menu.  Press the OK button to return to the MicroSurvey Assistant – Main Menu. 
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Step 3) Importing a Data Collector File 
 
From here we are going to go through the steps to read our data collector file from the hard drive 
into our program and save it into a traverse file. 
 
 
Pick on the button labeled Import ASCII 
File or Data Collector File.  You will see 
this next dialog box. 

 
 
We are going to import a data collector raw file so pick the button labeled Import Data Collector 
ASCII File.  This will bring up a dialog box with all the different collector types that we support. 
 

 
 
As you can see, the list of supported collector files is very large and includes all the major brands 
on the market.  For this tutorial we will use a file collected in the Topcon format.  (This is not 
saying that Topcon is the collector of choice, only that the file used in this tutorial was of this 
format.  All of the other collector formats would give equally suitable data in this type of job.) 
 
Pick the button labeled Topcon FC4/On Board (bottom left corner of the dialog).  As soon as 
you do you will be presented with the following dialog box; 
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This allows you to quickly check or change your toggles before proceeding.  Pick the OK button 
to continue. 
 
You will then be asked to give the file name of the collector file. Go to the C:\Documents and 
Settings\USER\My Documents\MicroSurvey\MSCAD\2010\JOBS2010\Examples directory 
and pick on the file Fc4-big2.raw. (where \USER\ is your user login folder) 
 

 
 
Once you have selected the correct file, press the OPEN button to continue. 

 

Step 4) Creating the Traverse File 
 
You will then be presented with the dialog box asking if this is a New or Existing Traverse. 
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This is a New Traverse so pick the New Traverse button.  Now you will be asked to name your 
traverse file.  This allows you to have several traverses in one job and keep them all organized so 
you can work on them separately. 
 

 
 
You can name your traverse file anything that makes sense to you.  I have chosen the name 
VOLUMES for the traverse. The program will use the project name as the default. Once you have 
entered the name press the Save button. 
 
Next you will be asked to enter some information about this traverse.  You may leave this blank if 
you wish but a good practice is to fill in the information as it is used later in printouts. 
 

 
 
Then press the OK button to continue. 
 
From this point, the program very quickly reads the raw data file from the hard drive and stores it 
into our traverse file.  You will see the information scrolling very quickly at the top of the screen in 
the prompt area.  You should see 4  points on the main screen. These were points entered as 
coordinates in the raw collector file.  The rest of the shots have been recorded as raw data and 
have not been coordinated. We will do that next... 

 

Step 5) Processing and Editing the Traverse File 
 

You will see this dialog box in the middle of the screen. 
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Pick on YES so we can see the raw data in the traverse file and confirm that it is correct and 
complete. If the Assistant is still open, close it down so you can work on the traverse file.  You 
should see the following window with the raw data from the survey. 

 

 
 

Step 6) Coordinate the Traverse 
 
 
 

Select Re-coordinate Traverse from the 
Edit Menu on the Active Drawing Editor.  
Or you can type Ctrl-R if the editor window 
is current. 
 
You will be given the option of creating a Re-
coordination Report or Log. Accept the 
defaults as shown: 
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Now you will see the coordinates being calculated in the prompt area on top of the screen as well 
as the information being drawn into the graphics window.  The entire job will be imported and 
displayed on screen. 
 

 

 
 
The linework you see is only temporary 
and will be erased as soon as you do a 
zoom command or a redraw command.  
You will be left with nothing but the points 
at that time.  To be able to do a zoom or 
redraw command we have to exit out of the 
MicroSurvey Assistant menus.  Press the 
OK button and then the EXIT button to get 
out of the assistant.  Then do a Zoom Fit 
(zoom extents) by picking this button on 
the left of the screen.  

 

 
You will now see the points as shown below. 
 

 
 
 

Step 7) Working with AutoMAP 
 
Our objective is to calculate the volume of this pile of earth.  To do this we need to layer separate 
the data to help us build the two surfaces.  In other words we want all the points with descriptions 
of TOP to be on one layer and the points with descriptions of BOTTOM on a different layer.  This 
will make it easier to select the correct points to create surfaces to generate volumes. 
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To do this we are going to use the AutoMap program.  You can find this in the MsTraverse 
pulldown | Automap System. This command is available in other locations as well. 
 
This will display the dialog box below. 
 

 
 
This is a powerful command but we will just use a portion of it’s power in this tutorial.  First thing 
you need to do is pick the New Library button.  This will remove the current listing of descriptions 
(which do not match our current job) and allow us to then pick the Scan Dbase button which will 
go to our job and look up every description we used and display them, ready for editing. 
 

 
 
This job has 3 different descriptions.  BOTTOM, TOP and NL.  We do not need the NL description 
as it only defined the control points and is not related to the surfaces we are creating, so we are 
going to delete this description from our list.  This will not erase the points for the job.  It only 
means that the points will not be relocated to another layer or have linework connecting them, so 
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do not worry.  Pick the description NL from the left side of the dialog and then pick the Delete 
button. 
 
You will be asked if you are sure that you wish to delete this description. 
 

 
 
Pick the YES button to continue. 
 
This will leave you with only the BOTTOM and TOP descriptions to be edited.  Now pick on the 
description BOTTOM and pick the Edit button.  You will now see this dialog box. 
 

 
 
 
This dialog box has many 
options on it.  The ones we 
are concerned with are in 
the bottom half.  Set your 
program to match the 
dialog here. We are not 
applying any symbols, but 
we are going to draw a 3D 
polyline connecting all the 
points with the description 
Bottom, in increasing point 
number order.  We are also 
moving the nodes, 
elevations and point 
numbers to the same layer 
as the description and 
polyline.  
Note: Set all the layer 
colors to Red. 
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When you have set all the options as above then press the OK button and edit the description 
TOP in the same method.  The settings are shown below. Note: Set all the layer colors to Blue. 

 
 
Pick the OK button after setting the above dialog. 
 
Lets save this library for future use.  Pick on the Save Library button. 
 

 
 
Give the library a unique name of VOLUMES, as shown above.  Pick the SAVE button to 
continue. 
 
Now all that is left is to process the settings for the descriptions.  Press the Process AutoMAP 
Connections Now button.   
 
Now you will see the following dialog box; 
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Because we are not using the Z-Coding option in this example, simply pick on the Skip XYZ 
Method button to continue. 
 

Using the Explorer (pick this button ) we will freeze the layers shown below by picking on the 
layer names to highlight them. Pick the “Thawed” word as shown below to toggle the value 
to “Frozen” to freeze the layers – lastly, exit the Explorer. 
 

 
 
Now your job should look like this. 

 
 
The Bottom points have all been placed on the BOTTOM layer and connected by a 3D Polyline 
and the Top points have all been placed on the TOP layer and connected separately by another 
3D Polyline.   
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Step 8) Start the First Surface 
Now we are ready to generate 2 surfaces to calculate volumes from.  The first surface 
will have all of the Top and Bottom points to define the upper surface of the pile.   

 
To do this we will load the toolbar from the MsModeling pulldown menu by picking on the option 
Modeling Toolbar….  The following toolbar will appear on screen.  Move it to a convenient 
location on the right of the screen. 
 

 
 
 
Next we need to set a setting to use the polylines consistently during extraction. 
Pick on this toolbar button (or go to the MsModeling menu | Configuration Settings) 

 
 
On the next dialog that comes up, pick on the button for Data Extraction. 

 
 
On the following dialog, we are going to make a single change.  Turn the Auto option off and set 
the size to a value of 2.  This will interpolate extra vertices along the polylines at this interval. 
 

 
 
Pick OK twice to get out of the dialogs. 
 
Next:  

To extract points to a surface, pick this button.  
 
The following dialog box will appear.  Please fill it out as shown below and then pick the OK 
button to continue.  
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After picking the OK button you will be asked to select all the points to be used in this surface.  
We need all of the points on screen to form the top surface so simply press the ENTER button 
to select them all. 
 
It should report in the command prompt area; 
 

Points extracted from  1350 entities.  
1432 points total in surface. 

 
We have now defined the surface by extracting the points, but we now also need the breaklines 
to add more detail and make the surface accurately reflect the surface edges of the pile. 

To extract the breaklines to the same surface, pick this button.  
The following dialog box will appear.  Please fill it out as shown below and then pick the OK 
button to continue.  Note: remove the Clear before extract checkbox (if it is on)! 
 

 
 
After picking the OK button you will be asked to select all the breaklines to be used in this 
surface.  We need all of the linework on screen to help form the top surface so simply press the 
ENTER button to grab them all. You should see something like this on the text screen: 
 
956 additional points added to current surface 

 

Step 9) Make the First TIN 

Next we need to create a TIN for this surface. Pick this button.  from the toolbar. 
 
The TIN command will ask you several questions.  Answer them as follows; 
 
Surface name <TOP>: <Enter> 
 
None/Show/Draw/Redraw <Show>? <Enter> 
 
This will temporarily display the TIN so we can confirm that the TIN has been generated correctly.   
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A redraw or zoom command will remove the TIN from the screen. 
 

 

Step 10) Start the Second Surface 
 
Now we need to create the Bottom surface.  It is difficult to pick the points around the outside 
edge of the pile without accidentally picking other points as well, so we will isolate the bottom 
layer on screen.  This command can be found on the MsTools | Layer Control Tools then pick 

the ISOLATE option.  Or you can pick this button  from the MS Layer toolbar. 
 

After the command loads you will be asked to: 

Select item on layer to isolate: Pick on one of the red lines, then press <ENTER> 
 
Now the job should look like this: 
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Step 11) Extract the Second Surface 

To extract the points to a new surface, pick this button.  
 
The following dialog box will appear.  Please fill it out as shown below and then pick the OK 
button to continue.  
 

 
 
After picking the OK button you will be asked to select all the points to be used in this surface.  
We need all of the points on screen to form the bottom surface so simply press the ENTER 
button to grab them all. 
 
It should report in the command prompt area; 
 
Points extracted from  213 entities.  
284 points total in surface. 
 
So far we have the points that help define the surface but we now also need the breaklines. 

To extract the breaklines to the same surface, pick this button.  
The following dialog box will appear.  Please fill it out as shown below and then pick the OK 
button to continue.  NOTE: Remove the Clear before extract check box(if it is on)! 
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After picking the OK button you will be asked to select all the breaklines to be used in this 
surface.  We need all of the linework on screen to help form the bottom surface so simply press 
the ENTER button to select them all. 
 
200 additional points added to current surface 

 

Step 12) Make the Second TIN 
 

 
Next we need to create a TIN for this second surface. Pick 
this button. from the toolbar. 

 
The TIN command will ask you several questions.  Answer them as follows; 
Surface name <BOTTOM>: <Enter> 
 
None/Show/Draw/Redraw <Show>? <Enter> 
 
This will temporarily display the TIN so we can confirm that the TIN has been generated correctly.   

 
 
A redraw or zoom command will remove the TIN from the screen. 

 

Step 13) Calculate Surface Volumes between the 2 Surfaces 
 
Now we can finally calculate the volume between the surfaces called TOP and BOTTOM. 
 
We can calculate the Surface volume and report it in two different ways.   
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First we will run the Surface Volume command from the MsModeling pulldown menu | 
Volumetrics. 
 
Fill out the two surface names as shown with the TOP surface on the left and the BOTTOM 
surface on the right.  Be sure to pick the check box beside Surface Name to be able to enter the 
BOTTOM surface 
 
Report Type: set it to Cut and Fill Volumes for this run through. 

 
 
Now pick the OK button and volumes will be calculated and displayed in the command prompt 
area on screen.  Flip to the command prompt window by pressing the F2 function key (a second 
time to return to the normal screen) 
 
The volume will be displayed like this. 
 
Using conversion factor of 1.                                                                                                    
 
Volume of TOP-BOTTOM based on a planar tin. 
 

Positive Volume         Negative Volume              Net Volume 
---------------                  ---------------                       ---------- 

               46499.552                -1.938e-005                      46499.552       
 
The negative volume shown here is so small that it does not affect the job in any way and was 
due to minor deviations in the way the two TINs were generated.  Your final volume is  
46,499.552 m3 (because our job was in metric – if it had been feet then the units would have 
been cubic feet by default) 
 
Report Type: Set it to Volumes and Average Values for this run through. 
 
Everything else remains the same. 
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The volume will be displayed like this. 
 
Using conversion factor of 1.                                                                                                    
 
Volume of TOP-BOTTOM based on a planar tin. 
 
                    Net Volume               plan area                 average Z 
                    ----------------               --------------               -------------- 
                     46499.552                8111.108                   5.733  
 

Step 14) Rendering the Top Surface 
 
To be able to render a surface, the TIN needs to be drawn into the drawing.  To do this, run the 

TIN command again from this button . 
 
This time when asked, set the surface to TOP and DRAW the surface. 
 
Surface name <BOTTOM>: TOP <Enter> 
 
None/Show/Draw/Redraw <Show>? D <Enter> 
 
The triangles are now part of the drawing and can be viewed in full 3D by going to the View menu 
| Rendering | Render. 
 
Double click on the center of the surface then use your mouse to pick and rotate the surface as 
you desire.  Experiment and have fun! 
 
 
 
Your surface should look like this. 
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Close the Render window, and delete the tin from the screen.  It is no longer needed. 
 

Step 15) Cross Sections across the Job 
 
For those who wish to confirm the volume by seeing cross sections to prove the answer, we have 
just the feature to do this. 
 
Under the MsDesign pulldown menu | AutoRoute options there is a command Across Full 
Surface. 
 
You will be asked which surface you wish to plot.  Select TOP and press OK. 
 

 
 
Next you will be asked which way do you wish to run the center line for all the cross sections to 
be related to.   Then you will be asked for the Interval for the cross sections. 
 
Begin on which side of surface North/South/East/<West>: N  <Enter> 
 
Enter cross section interval: 20 
 

A center line and cross section lines will be drawn over the job as reference. 
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If you wish, you can erase these lines, or leave them for later reference.  Your choice!  
 

 
 
I left them on in my example by answering NO. 
 
Next you will be asked if you wish to plot the cross sections.  
  

 

Answer Yes to this and you will get 
the following dialog box that controls 
the grid on the cross sections. 

 
Fill your dialog box out as 
shown above and when 
completed press the OK 
button.  Note: This job is a 
Metric job, so the width and 
height of the sheet are in 
mm. If you were working in 
feet, you would put in the 
inch size of the paper you 
were using, like 24 x 36 
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. When you pick the Ok button, You will be prompted with: 
 
Pick lower left corner:  This is the insertion point for the cross sections so select a starting point 
over to the right of the diagram so they do not overlap each other. 
 
Below is one of the cross sections enlarged.   
 

 
 
 
You can change the color of the layers to get better visual results or for setting pen widths for 
plotting.   

 
As a double check you can calculate the volume under the cross sections, to work out the volume 
the old hand method. 
 
Save your job by picking the SAVE command from the File pulldown menu.  Then be sure to 
save your surfaces.  Go to the MsModeling menu | Surface Operations, to bring this dialog up. 
 

 
 
Highlight both surface names, then pick the Write QSB button. 
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Name the QSB file VOLUMES, then pick Save to finish the command.  Pick OK to exit the 
previous dialog. 
 
(End of tutorial) 
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Road Design Tutorial 
 
 
Because of the size and complexity of this tutorial we have broken it down into 11 smaller steps 
to make it easier for you to follow. 
 
 
Step 1) Opening the Job 
 
Step 2) Create the Ground Surface 
 
Step 3) Rendering the Surface 
 
Step 4) Inputting the Horizontal Alignment 
 
Step 5) Stationing and Saving the Horizontal Alignment 
 
Step 6) Create Profile 
 
Step 7) Design New Profile 
 
Step 8) Create Cross Section Template 
 
Step 9) Create New Road Surface 
 
Step 10) Output Cross Sections 
 
Step 11) Saving the Drawing and Surfaces 
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Step 1) Opening the Job 
Start by opening the CONTOURS.DWG file from the Project Manager.  The CONTOURS.DWG 
file should reside in your C:\Documents and Settings\UserName\My 
Documents\MicroSurvey\MSCAD\2010\Jobs2010\Examples directory by default. (where 
UserName is the user logged into that computer) 
 

 
 
Pick on the job name and then pick the Open button. 
 
The system General Configuration Options should be set to match the following for this job to 
work cleanly.  Press the OK button once they are confirmed to be correctly set. 
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You will see a series of contours and a few points.  They will be used to define your existing 
surface. 
 

 
Do the SAVEAS command to create a new drawing using the contours as a starting point.  This 
will protect the original data so you can execute the exercise again if you wish. 
 
Type SAVEAS and press enter, or go to the File pulldown menu and pick on the SAVEAS 
command.. 
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Change the default folder to save in C:\Documents and Settings\UserName\My 
Documents\MicroSurvey\MSCAD\2010\Jobs2010 (where UserName is the user logged into 
that computer) and change the file name to CONT.DWG  then pick the SAVE button to continue. 

Step 2) Create the Ground Surface 
 
Next, we need to extract all of the 3D point data and 3D breaklines (contours) to create the 
existing surface. 
 
To set the program up so we can select only the data required to extract to a surface, we need to 
go to the MsModeling menu | Configuration Settings. 
  

 
Pick on the Data Extraction button 
Turn on the toggle for Filter by Entity and set your Density Step Size to 2 by turning the Auto 
option off.  
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Pick OK to return to the previous dialog and OK again to exit the dialog. 
 
Next we will load the Modeling toolbar from the MsModeling pulldown menu by picking on the 
option Modeling Toolbar.  The following toolbar will appear on screen.  Move it to a convenient 
location on your screen (can be docked anywhere you wish). 
 

 
 

To extract points to a surface, pick this button.  
 
The following dialog box will appear.  Please fill it out as shown below and then pick the OK 
button to continue.  
 

 
 
After picking the OK button you will be asked to Pick the correct items from a filter list, to extract 
entities from the drawing.  You will then see the following dialog: 
 

 

 
 
 
Pick on POINT 
and then pick 
the Select 
button. 

 
 
 
Points will now 
be the only entity 
that can be 
selected. 
 
Pick OK to 
continue: 

 
The command line will now display: 
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Return to select all visible or 
Select entities: 
 
We need all of the points on screen to form the top surface so simply press the ENTER button to 
grab them all. 
 
It should report in the command prompt area; 

21 points total in surface. 
 

So far we have the points that help define the surface but we now also need the breaklines. 
 
 

To extract the breaklines to the same surface, pick this button.  
The following dialog box will appear.  Please fill it out as shown below and then pick the OK 
button to continue.  
 

 
 
After picking the OK button the Entity Filter dialog will come up again. 
It will default to only points being the list.  Pick Reset to see the complete list.  Then pick on LW 
Polyline and the select button to short list it to only the LW Polyline. 

 
 
Pick OK to continue: 
 
The command line will now display: 
 
Return to select all visible or 
Select entities:  
 
We need all of the linework on screen to help form the top surface so simply press the ENTER 
button to grab them all. 
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The command line will now display: 
 
1916 additional points added to current surface 

Next we need to create a TIN for this surface. Pick this button.  from the palette. 
 
The TIN command will ask you several questions.  Answer them as follows; 
 
current surface <GROUND>:(or Select): <Enter> 
 
None/Show/Draw/Redraw <Show>? <Enter> 
 
This will temporarily display the TIN on screen, so we can confirm that the TIN has been 
generated correctly.   

 
 
A redraw or zoom command will remove the TIN from the screen.  The Tin will remain in memory. 

Step 3) Rendering the Surface 
 
To look at the surface from any 3D angle, we would first need to Draw the surface to our screen, 
rather than just using the Show option. 
 
To control what layer the TIN is drawn on, go to the MsModeling menu | Surface Operations (or 

pick on this toolbar button ) to bring up this dialog. 
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Highlight the Ground surface and then pick the Detailed Info button to bring up the next dialog. 
 
At the top in the middle of this dialog, you can control what layer the TIN will be drawn on. 
 

 
 
Set it to GROUND and pick OK to return to the previous dialog.  Then pick OK again to exit the 
dialog. 
 

Now we can draw the TIN into our drawing.  Pick this button.  from the toolbar. 
 
The TIN command will ask you several questions.  Answer them as follows; 
 
Surface name <GROUND>: <Enter> 



 

132  Getting Started in MicroSurvey CAD 2010 

None/Show/Draw/Redraw <Show>? D <Enter> 
Lines/3dFaces/Polyface <Polyface>: <Enter> 
Select Invisiblity... All/Interior/Between breaks/None <None>: <Enter> 
 
Now the TIN will be part of the drawing and drawn on layer Ground. 
 
To make it easier to view, we will isolate the ground layer, so nothing else is on screen. 
 

You can do this by going to the MsTools menu | Layer Control |  
 
Select entities:           pick the TIN you just drew 
Entities in set: 1        <enter> 
Select entities:          <enter> 
 
Now all you have on screen is the TIN layer. 
 
Go to the View menu | Rendering | Render and you will see the following Render Window: 
There are various options available to control what you see and how you control what you view. 

 
 
You can spin the surface around in real time by use of the mouse.  The Rendering chapter covers 
all of the different options you have available. 
 
You can now exit the window and return to the normal drawing. 
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To bring the rest of the layers back to the screen go to the MsTools menu | Layer Control | 

. 
 
The TIN does not need to remain in the drawing for the rest of the exercise, and can be deleted 
by going to the Edit menu | Delete, and picking the tin to select it, and press enter to complete the 
command. 
 

Step 4) Inputting the Horizontal Alignment 
 
Now that we have our surface we can create our alignment. 
 
Start by going to the MsDesign pulldown menu | AutoRoute and picking the 

 command. 
 
In the Command prompt area, it will ask you the following, please enter the information shown: 
Enter name for horizontal alignment:  <>: MAPLE 
 
* NOTE * 
When naming a horizontal alignment, be sure to use only a single word, with no spaces, as the 
name, such as: 
ROAD1, Orange_Side_Road, Maple_Street, Pine-Street, Maple 
 
From point: -200,100 
To point: 1,90 
To point: 70,-45 
To point: 240,-50 
To point:  <Enter> 
 
Note: It is not necessary to enter exact coordinates to create an alignment. You can also "pick" 
the points on screen using Object Snaps, as appropriate. 
 
The center line of the road is now drawn. 
 

 
 
Next you will be asked if you wish to edit the alignment: 
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Answer Yes so we can insert new curves and spirals. 
 
Edit alignment. Add/Delete/Move/sHift/Curve/Scs/Tangent:  SCS 
 
Select POT (or linework) to add/edit scs: <pick the red circle at the FIRST bend in the road> 
(zoom in if you can not pick it easily.  Don’t miss it!) 
 
Now you will see the following dialog box. 

 
 
Fill in the values shown on the dialog above, and the calculations are automatically updated.You 
can name the spiral-curve-spiral and export the report to the View Log file.   
Pick the OK button to place the spirals and curve on the screen. 
 
Select POT (or linework) to add/edit scs: <Enter> 
 
Edit alignment. Add/Delete/Move/sHift/Curve/Scs/Tangent: Curve 
 
Select POT (or linework) to add/edit curve: <pick the red circle at the SECOND bend in the 
road> (zoom in if you can not pick it easily.  Don’t miss it!) 
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Enter curve radius: 50 
The rest of the curve data it automatically calculated and displayed in the dialog. 
Pick OK to draw the curve to the screen. 
Select POT (or linework) to add/edit curve:<Enter> 
 
Edit alignment. Add/Delete/Move/sHift/Curve/Scs/Tangent:  <Enter> 
 
Now you will be asked if you wish to continue and profile the existing ground surface? 
 

 
 
Pick NO for now. 
 
At this point your job should look like this (your colors may be different): 
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Step 5) Stationing and Saving the Horizontal Alignment  
 
Before we continue with the profile lets label the stationing along the alignment. 
Go to the MsDesign pulldown menu | AutoRoute pick on the Label Alignment option 
 
Label alignment. Stations/Offsets/Newpt/Existingpts/Report: S   
 
STATIONS 

 
There are many options to label and create points along the alignment and on offsets, as well as 
reports. 
 
We are going to simply label points along the centerline in this example. 
 

 
 
Pick OK to continue 
 
After picking the Alignment name and beginning station, you will have the following dialog box 
appear: 
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Fill in the table as shown and pick OK to continue. 
 
Label alignment. Stations/Offsets/Newpt/Existingpts/Report:<ENTER> 
 
Here is what you will see on screen, 
 

 
 
and a close up showing a portion of the labeling, 
 

 
 
You can see that the tangent, curve and spiral have had the stationing labeled, as well as the 
beginning of Curve and Spiral.  New points have been created along the centerline with the 
description set as the station.  Some text overlap is apparent and a simple move command can 
clean this up.   
 
Now we should save this alignment to a file to protect us and allow us to retrieve it without having 
to recreate it from scratch. 
 
Under the MsDesign pulldown menu | AutoRoute pick on the Write .HRZ File option. 
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  confirm the alignment name and pick OK to continue. 
On the command prompt window you will see the message that tells you where and what the file 
is called. 
 
Alignment saved in C:\Documents and Settings\Glen\My 
Documents\MicroSurvey\MSCAD\2010\Jobs2010\MAPLE.HRZ. 
 
Here is the contents of this file: 
 
HRZVERSION=3::MAPLE 
100.00000000,-200.00000000,0.00000000 
90.00000000,1.00000000,0.00000000,50.00000000,50.00000000,1.00000000,1,100.00000000,0 
-45.00000000,70.00000000,50.00000000,0,0,0,0,0,0 
-50.00000000,240.00000000,0,0,0,0,0,0,0 
 

Step 6) Create Profile 
 
Now that we are finished labeling and saving the horizontal alignment – lets continue with the 
vertical profile. 
 
Go to the MsDesign pulldown menu | AutoRoute and pick the Extract Existing Ground 
Profile option. 
 
You will be asked to pick from a list of surfaces – we want GROUND as our surface. 
 

 
 
Pick on the word GROUND and pick the OK button. 
 

 
 
Confirm the alignment you are working with and pick OK to continue. 
 
Next you will be shown a dialog box that will control how the profile will be drawn. 
 
Change the settings to match this dialog: 
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The only value you need to change is the Grid Interval Horizontal from 100 to 10.  Press the OK 
button to continue. 
 
Pick lower starting corner of grid: <Pick Somewhere Appropriate – maybe Above the 
Alignment> 
 
You will be asked if you wish to create the design profile? 
 

 
 
Answer NO for now. 
 
Now lets set the Profile_Grid layer to gray (color 9) for easier visibility,   Go to the Explore Layer 

button  and pick on it. 
 
Then pick on the layer name above, and change the color to gray(9). 
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The close the dialog to continue. 
 
Now the profile will look like this: 
 

 
 

Step 7) Design New Profile 
 
Now that we have had a chance to look over our existing profile, we now need to create a design 
alignment. 
 
Go to the MsDesign pulldown menu | AutoRoute and pick on the Design Vertical Alignment 
option. 
Draw new profile grid or use existing New/<Existing>: <Enter> 
 

 
 
Confirm the grid to work on and pick OK to continue: 
 
Enter name for vertical alignment:  <>: MAPLE 
 
NOTE:  
When naming a Vertical alignment, be sure to use only a single word, with no spaces, as the 
name, such as: ROAD1, Orange_Side_Road, Maple_Street, Pine-Street, Maple 
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At this point, the program will draw a rubber band line from the bottom left corner of the graph.  
This helps you to find the starting end of the profile. Pick on the graph where you wish to start the 
new profile line. 
 
Pick first VPI location:  <pick near the left edge around the existing profile> 
 
Change the dialog box that comes up, so the station and elevation look like the following; 
 

 
 
Pick the OK button. 
Next pick somewhere around the middle of the profile and change the dialog box so the station 
and elevation match the following; 
 

 
 
Pick the OK button. 
and lastly pick over near the top right and change the settings so the station and elevation match 
the following. 
 

 
 



 

142  Getting Started in MicroSurvey CAD 2010 

Pick the OK button. 
Press ENTER to continue. 
 
Next you will be asked: 
 

 
 
Pick YES to continue. 
 
Now you will be prompted, 

Add/Curve/Delete/Move/Freezethawgrid:CURVE 

 
Select VPI (or linework) to add/edit curve: <Pick the Red Circle at the FIRST bend in the 
vertical alignment> (zoom in if you need to, to be able to pick the red circle cleanly – don’t miss 
it) 
 
Current curve length (in stations) = 0.000000 
Select method to define curve length: Pick/Type: TYPE 
 
Enter curve distance: 150 <Enter> 
 
Select VPI (or linework) to add/edit curve: <ENTER> 
 
Add/Curve/Delete/Move/Freezethawgrid:  <ENTER> 
 
Next you will be asked if you wish to pass our cross section template along the design alignment 
and create a new surface.   
 

 
 
Answer NO for now because we need to create the template first. 
 
Before we create the Cross Section Template, lets label the vertical curve. 
Go to the MsDesign pulldown menu | AutoRoute and pick on the Query/Label VPI option. 
 

 
 
Confirm the vertical alignment grid to use, pick OK to continue: 
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Select existing VPI: <Pick the Red Circle at the FIRST bend in the vertical alignment> (zoom 
in if you need to, to be able to pick the red circle cleanly – don’t miss it) 
 
You will see the following dialog box. 
 

 
 
Be sure to pick the Label Curve box to turn it on.  Then pick the OK button to continue. 
 
The curve will be label as shown below: 
 

 
 
Select existing VPI:<enter> 
Now to give us a copy of the vertical profile in a file, 
 
Go to the MsDesign pulldown menu | AutoRoute and pick on the Write .VRT File option. 
 

 
 



 

144  Getting Started in MicroSurvey CAD 2010 

Confirm the vertical alignment and pick OK to continue. 
 
The command prompt will display the following to confirm it was saved. 
C:\Documents and Settings\Glen\My Documents\MicroSurvey\MSCAD\2010\Jobs2010\PGRID-
0.VRT saved. 
 
Here is the contents of this file:  
 
VPI 1      STA 0.000           Z 101.250 
VPI        STA 225.000         Z 111.000  L 150.000 
VPI        STA 505.290         Z 117.300  L 0.000 
END 

 

Step 8) Create Cross Section Template 
 
Now you will create a template for our road cross section. 
 
Go to the MsDesign pulldown menu | AutoRoute and pick on the Create Cross Section 
Template option. 

You will see a template editor on screen.  This editor has many options that need to be filled 
out. 

 
 
We will use the default supplied, but make note of all of the options you have available. 
 
Pick the SAVE button.  This will allow you to save the template for future use in this and any other 
project. 
 
Give the template the name of MAPLE, as shown. 
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Pick the SAVE button to continue. 
 

 
The file name and location will now be displayed in the dialog. 
Pick DONE to continue. 
 
The following message is also placed in the command prompt window. 
 
Cross section template file saved as C:\Documents and Settings\Glen\My 
Documents\MicroSurvey\MSCAD\2010\Jobs2010\MAPLE.TMP. 

Step 9) Create New Road Surface 
 
Now that the cross section template is complete, we can now apply it to the design alignment.  
Go to the MsDesign pulldown menu | AutoRoute and pick on the Create New Design Surface 
option. 
 
You will then see the following dialog box: 
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Pick on our MAPLE template then pick the OPEN button to continue. 
 
The following dialog comes up next, 
 

 
 
You need to confirm the surface and alignment names match the box shown above.  Press the 
OK button. 
 
After a short period of time (a few seconds or so), the following prompt appears in the command 
window. 
 
Draw or Show new TIN? Draw/Noshow/<Show>: 
 
Press enter to default to Show 
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Answer YES 

 
Answer YES 
 
This will export a LandXML file that will be able to be uploaded to our FieldGenius data collector, 
for use in the field, or to many other programs that can read this file format. 
 

 
 
Set the intervals as show.  Pick OK to continue. 
 
Your drawing should now look something like this: 
 
 

 
 
 
After seeing the TIN you can hit the redraw button to clear the TIN.  The Surface does stay in 
memory for future use. 
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What you will now see on screen is the road with the template applied, showing the outer edge 
where the template intersects with the original surface. 
 

 
 

 

Step 10) Output Cross Sections 
 
Now lets get some cross sections along the alignment. 
Go to the MsDesign pulldown menu | AutoRoute and pick on the Extract Cross Sections 
from Alignment option. 
 

 
 
Confirm the Alignment and pick OK to continue. 
 
Be sure to set the next dialog box exactly as shown below to ensure you get the correct results.  
Special attention to ensure you select BOTH surfaces as shown. 
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Pick the OK button to continue. 
 

 
 
Answer YES. 
 
This will draw lines on the plan view of the alignment to show where the cross sections will be 
extracted from. 
 

 
 
Then: 
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Answer YES then you will have only the 3D section lines left. 
 

 
 
When you answer YES you will be shown another dialog box that controls the output of the 
sections.  Please fill it out exactly as shown: 
 

 
 
Pick the OK button to continue. 
 
Pick lower left corner:  <this is the starting location for the sections to be drawn> (go to the 
right of the drawing so they do not overlap on screen) 
 
You will see the sheet size outlined and the sections draw within the sheet. 

 
 
Changed the color of Layer GRID to gray (9) as we did for the profile, above.  Here is a close up 
of a few of the sections: 
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Step 11) Saving the Drawing and Surfaces 
 
 
Be sure to save the drawing and the surfaces. 
 
To Save the Drawing, Simply pick on the Save button or go to the File menu and pick on the 
Save command.  Your finished drawing should look something like this: 
 

 
To save the surfaces you need to go to the MsModeling menu | and this 
dialog will come up: 
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Pick on the 2 surfaces as shown above and pick the Write QSB button. 
Enter in the file name CONT and pick Save. 
 

 
Pick OK to exit the command.   
 
Now the surfaces and the drawing are both safe!  You can now exit the program with the ability to 
reopen the drawing and reload the surface file, if you need to do further work in it. 
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 House Placement Tutorial 
 
Because of the size and complexity of this tutorial we have broken it down into 9 smaller steps to 
make it easier for you to follow. 
 
Step 1) Open the Job 
 
Step 2) Working with the Toolbox 
 
Step 3) Entering a Lot 
 
Step 4) Defining the Lot Sides 
 
Step 5) Entering a House 
 
Step 6) Defining a House 
 
Step 7) Placing a House on the Lot 
 
Step 8) Computing Stakes 
 
Step 9) Staking Reports 
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Step 1) Open the Job 
 
To begin, start a new drawing by running the MicroSurvey Project Manager… command, found 
under the File drop-down menu. 
 

 
 
Pick the New button on the Project Manager, and name the job LOT.  
 

 
 
Pick Save to continue. 
 
Next you will see the following dialog box. 
Set the defaults as shown here 
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At the bottom of the above dialog box, pick on the Toggles button.  This brings up the following 
dialog boxes. 
Set the Toggles as shown here. 
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Now pick the OK button to return to the previous dialog and pick OK again to exit and save the 
settings in that dialog box. 

 

Step 2) Working with the Toolbox 
 
Go to the MsTools  pulldown menu -| Subdivision Toolbar… option. 
 

 
 
The toolbox and can be dragged to any location on screen (by picking in the top bar in the 
Toolbox and while holding the mouse button down, drag it to the desired location) to make it easy 
to access but not cover the drawing. 
 

 

Step 3) Entering a Lot 

Pick on this button:  
 
You will now be asked if you are entering a lot or block. 
 

 
 
In this example we will pick on the top button to enter a Lot. 
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(Create/Edit Lots) 
 
Now you will be asked which of the 3 different ways you wish to enter the lot information. 
 

 
 
Pick on the first button: (Create/Edit Lots Manually) 
 
Now fill out the next dialog as show, with the lot number. 
 

 
 
Pick on the OK button to continue. 
 
You will then be given some reminders on how to enter your lot. 
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Pick on the OK button to continue. 
 
Now you will see the following dialog: 
 

There will be many things to enter 
on this dialog.  To start with you 
need to tell the routine if you are 
entering a line or curve – then 
press enter to continue.   
 
Then you will be asked to fill in 
each piece of information on that 
line or curve.  Press enter after 
each piece of info has been 
entered. 
 
After entering this info – press 
Append and you will be given the 
previous dialog again, ready for 
new numbers.  You will also see 
the lot taking shape in the 
drawing after each side is 
entered. 
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Here are the remain pieces of information for you to enter:   
 

 
 
As you continue to enter in the 
individual line and curve data, you 
will see the preview of the drawing 
on screen.  It will show the 
segment you are currently entering 
so you can confirm it looks correct.  
If it is incorrect, you can make 
changes before Appending it to the 
lot. 
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After you enter in all of the info on the last dialog – pick the FINISH button to continue. 
 
You will be presented with the following: 
 

 
 
Pick the YES button to continue. 
 

 

Step 4) Defining the Lot Sides  
 
At this point you have the following lot drawn. 
 

 
 
The following dialog is on screen: 
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You need to pick on each of the 4 buttons labeled Front, Left, Rear and Right, one at a time and 
then pick the linework related to the button. 
 
To start, pick the FRONT button and then pick the first line we drew.  Then press enter to 
continue. 
 
Then pick the LEFT button and pick the second line we drew. Then press enter to continue. 
 
Then pick the REAR button and pick the first curve and the next line we drew. Then press enter 
to continue. 
 
Finally pick the RIGHT button and pick the second curve and last line we drew. Then press 
enter to continue. 
 

The lot sides should have changed color to match the buttons on the dialog, as shown 
below: 

 



 

162  Getting Started in MicroSurvey CAD 2010 

 
 
Pick the FINISH button to continue.  Next a window will appear showing you the lot report. 
 

 
 
You may print it by going to the File pulldown menu in this window and picking the Print 
command. 
 
You may close the window by picking the X in the top right corner of the window. 
 
Now you will be asked (and it may have been on screen already) 
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Pick on NO to finish the lot entry. 

 

Step 5) Entering a House 

Pick on this button:  
 
This will bring up the Building Library dialog. 

 
 
This dialog will display any structures already saved in the library and if you pick on one the 
preview will show up as well. 
Pick on the NEW button to add one. 
 
You will be given 2 different ways of entering house data. 
 

 
 
We will pick on the first button to continue. 
 
(Create Building Manual) 
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Next give the house a name of Tutorial and pick the OK button to continue. 
 

 
 
A new drawing is started automatically, using the name of the house. 
 
Similar to the lot entry, the following dialog is displayed as a reminder of how to enter the 
information. 
 

 
 
Pick the OK button to continue. 
 
Pick each of the entries shown to define the units and direction the line is to be drawn in, and 
then press enter after each value is entered. 
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Pick the FINISH button to continue. 
 
You will see the following dialog: 
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Pick YES to continue. 
 

 

Step 6) Defining a House 
 
At this point you have the following house drawn. 
 

 
 
The following dialog is on screen: 

 
 
You need to pick on each of the 4 buttons labeled Front, Left, Rear and Right, one at a time and 
then pick the linework related to the button. 
 
To start, pick the FRONT button and then pick the first line we drew.  Then press enter to 
continue. 
 
Then pick the LEFT button and pick the second line we drew. Then press enter to continue. 
 
Then pick the REAR button and pick the next 3 lines we drew. Then press enter to continue. 
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Finally pick the RIGHT button and pick the last line we drew. Then press enter to continue. 
 

 
 
Pick the FINISH button to continue. 
 
Your house has now been saved in the house library  

 

Step 7) Placing a House on the Lot 
 
Now we need to place the House on the Lot.  We do this by picking this button from the toolbox. 
 

 
 
It will bring up the following dialog box.  Fill it out as shown. 
 
 

 
Once you pick the Insert Building button, 
the house we designed will now be 
attached to your crosshair and is ready for 
placement. 

 
NOTE: As you move the house around you can see the side ties update dynamically.  You can 
switch between rotating, translating and scaling the house by following the instructions on the 
dialog.  You may move the dialog out of the way by picking the top bar and dragging it to the side. 
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You will see the house ties update as the 
house is moved in any direction, giving you 
the closest tie to the property line, in each 
direction 
 
 
 
 
 
 
 
 
 
 
 
 

Here are a couple of examples as we move the house around and rotate it to get what we desire. 
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Now we need to pick the desired location with the mouse, to place the house roughly on the lot. 
 

Once the house has been placed roughly 
on the lot, you will have the ability to fine-
tune the exact location by using this 
“Tuner" dialog.  
 
You have course and fine control with the 
outer and inner directional buttons.  You 
can also specify the amount of movement 
for the two settings.  You may also rotate 
the house by the rotation arrows and even 
set the rotation based upon the angle 
between the house and the lot. 

 
 

 

You decide where you wish to place your house.  Mine is set as shown. 

 
When you are happy with the final placement then pick the Place Building button to continue. 
 
Your house is now coordinated and points are placed on the house corners based upon the 
starting number and elevations set earlier. 
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Step 8) Computing Stakes 
 
Now that you have the house on the lot, we need to add a few stakes to make it easier for the 
construction crew to layout the house in the field. 
 
 
 
We will add a few stakes around the footprint of the house, 
offset back from the actual footprint.  To do this we will go 
to the MsPoints drop-down menu | Compute Points and 
pick the Compute Stakes… option.   
 
 
Pick the highlighted button shown here, to place stakes at 
the building corners, offset from each line. 
 
 
Confirm the starting point number and offsets and elevation 
of the points you are about to place.   
 
 
Once all values are entered as desired, pick the GO button, 
then on the drawing you will need to pick the appropriate 
lines and offset sides, to place the stakes required. 
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Then pick the house sides where you wish to place points. Pick the sides so that you get points 
as shown below:  (The white window at the top of the dialog box will give you instructions to walk 
you through placing points) 
 

 
 
Press the ESC button to end placing new points and return to the previous dialog.  Set other 
points if you desire, by using some of the other routines. 
 
Pick the OK button to end the command. 
 

Step 9) Staking Reports 
 
Now that we have some stakes set, we need to generate a staking report for the field crew. 
 
Go to the MsPoints drop-down menu | and pick on the Stake Out Points option. 
 

You will see the following dialog box: 
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In the small white rectangle, enter in the 
point range for the stakes.  In my 
example I typed 500..505  
 
Then pick the + sign to the right. 

 
The points on screen should now have little yellow X’s on them.  
 
 
 
Now pick on the Coordinate Point Report button. 
Then confirm the report file location and name: 
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Pick the OK button to continue. 
 
The coordinate report is created and displayed in our editor.  You may print this report by going to 
the File pulldown menu | Print. 
 

 
 
You may close the window by picking the X in the top corner of the window. 
 
Now pick on the Angle/Distance Report button. 
Then confirm the report file location and name: 
 

 
 
Pick the OK button to continue. 
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Enter in the setup and backsight point 
numbers as show, and pick on the 
sorting method (we will do Angle first 
then Number), then pick on the Add 
Shots button. (now do the Number 
option and pick Add Shots again) 

 
The drawing will have yellow lines from the setup to each stake.  They are temporary and will be 
removed with a redraw or zoom command. 
 

 
 
Now pick the View Report button to see the two reports we generated. 
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The first was sorted by Angles the second by Point Numbers. 
 
You may print this report by going to the File pulldown menu (in this window) and pick the Print 
option. 
 
You may close the window by picking the X in the top corner of the window. 
 
Pick the OK button to continue. 
 
Save your job by going to the File pulldown menu and picking on the SAVE option. 
 
(End of tutorial) 
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